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Utiliser LibreOffice sur un Mac

Sur Mac, certaines touches et certains éléments de menu sont différents de ceux utilisés sous
Windows ou Linux. Le tableau ci-dessous donne quelques substitutions courantes pour les instruc-
tions de ce chapitre. Pour une liste plus détaillée, voyez I'Aide de I'application.

Windows ou Linux |Equivalent Mac Effet

Sélection du menu

- . LibreOffice > Préférences Acces aux options de configuration
Outils > Options

Control+clicouclic droit
selon la configuration de I'ordinateur

Clic droit Ouvre un menu contextuel

Ctrl (Control) (Command) Utilisé avec d’autres touches
Ctri+Q (2)+Q Quitter LibreOffice
Fi1 o8]+ T Ouvre I'onglet Styles du volet latéral
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Introduction

Les diagrammes et les graphiques sont souvent des moyens puissants de transmettre de l'infor-
mation au lecteur. Calc propose une variété de formats de diagrammes et de graphiques pour vos
données.

Avec Calc, vous pouvez personnaliser vos diagrammes et vos graphiques de maniére trés pous-
sée. Toutes ces options vous permettent de présenter vos informations de la maniéere la meilleure
et la plus claire.

Créer un diagramme avec I’Assistant

Utilisez I'Assistant de diagramme pour créer un diagramme a partir des données d’un classeur.
Une fois le diagramme créé en tant qu'objet dans votre classeur, vous pouvez alors changer le
type de diagramme, modifier les plages de données et éditer le diagramme avec les options de cet
assistant. Chague changement que vous effectuez est automatiquement reporté dans I'objet dia-
gramme.

Apercu de I'assistant Diagramme

Pour faire la démonstration de la méthode pour réaliser des diagrammes et des graphiques dans
Calc, nous allons utiliser la petite table de données de la Figure 1.

F11 ¥l fx ¥ v =

_ | A _ B | & | D
1 Locations d’embarcations
)| Canoés Bateaux Rafts
3 |[Janvier 12 23 47
4 Février 9 31 54
5 Mars 14 27 56
6 IAvriI 17 28 48
7 [Mai 13 19 39
8 IJuin 8 27 52

Figure 1 : Table de données pour les exemples de diagrammes.
Voici un apercu des étapes de base :

1) Mettez tout d’abord en surbrillance (sélectionnez) les données a inclure dans le diagramme,
y compris les noms, catégories et étiquettes. Il n’est pas indispensable que la sélection soit
une plage contigué, vous pouvez également choisir des cellules individuelles ou des groupes
de cellules (colonnes ou lignes). Pour cet exemple, le mieux est peut-étre de sélectionner la
plage de cellules A2:D8 en omettant intentionnellement le titre général « Locations d’embar-
cations » du diagramme.

:Q/_ Astuce

Avant d’ouvrir I'assistant de diagramme, placez le curseur n'importe ou dans la zone de don-
nées. L'assistant de diagramme discernera généralement correctement la plage de don-
nées. Faites juste attention a ne pas inclure le titre du tableau de données.

2) Ouvrez la boite de dialogue de I'assistant de diagramme

— en choisissant Insertion > Diagramme dans la barre de menu,
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— en cliquant sur I'icone Insérer un diagramme | dans la barre d’outils Standard.

Les deux méthodes insérent un diagramme par défaut dans la feuille, ouvre la barre d’outils
Formatage dédiée et I'Assistant de diagramme.

60
50

40

30 W Canoés
M Bateaux

J ‘ ‘ J Raﬂs
0 ‘ '

Janvier Février Mars Auvril Juin

2

o

1

o

Figure 2 : Exemple de diagramme créé automatiquement par I'Assistant de diagramme.

3) Sélectionnez le type de diagramme et choisissez les options que vous souhaitez. Elles sont
présentées ci-dessous.

4)  Cliquez sur Terminer pour enregistrer les sélections et refermer I'assistant de diagramme.

Les sections suivantes offrent des détails supplémentaires sur I'utilisation de I'assistant de dia-
gramme.

Choisir le type de diagramme

Calc propose un choix parmi dix types de diagrammes de base, avec quelques options pour
chaque type. Ces options changent selon le type de diagramme que vous choisissez. Pour plus
d’informations sur les différents types de diagrammes, voir la « Galerie de types de dia-
grammes » page 65.

Les choix par défaut sont des diagrammes a deux dimensions (2D). Seuls certains types ou la 3D
est applicable (Colonne, Barre, Secteur et Zone) vous donnent la possibilité de sélectionner un
rendu 3D. L'apercu de la variante sélectionnée est entouré d’une bordure double et son nom (Nor-
mal sur la Figure 3) est affiché sous celui-ci.

Pour modifier le type de diagramme et les options associées :

1) Choisissez un type de diagramme (Figure 3) en cliquant sur son icone dans la liste sous
Choisissez un type de diagramme.

2) Sinécessaire, sélectionnez une variante en cliquant sur son apercu a droite de la liste. Les
apercus sont mis a jour a chaque fois que vous sélectionnez un type de diagramme différent.
Le diagramme change instantanément pour refléter la sélection.

3) Pour utiliser un diagramme en 3D, cochez I'option 3D et sélectionnez un type de vue (réa-
liste ou simple). Cette option n’est disponible que pour les types de diagrammes Colonne,
Barre, Secteur et Zone.

2 | Chapitre 3 — Créer des diagrammes et des graphiques



4)  Cliquez sur Suivant > pour modifier la plage de données, les séries de données et les élé-
ments du diagramme présentés plus en détail ci-dessous.

5) Quand le diagramme vous convient, cliquez sur Terminer pour fermer I'assistant de dia-

gramme.

Assistant de diagramme

Etapes

1.Type de diagramme

2.Plage de données
3.Séries de données
4 Eléments du diagramme

Choisissez un type de diagramme

1

" Barre

Secteur
s Zone
= Ligne
|- XY (dispersion)
[-* Bulle [ 13D
« Toile

Réaliste .

Forme

li: Cours
l Colonne et ligne

Normal

Figure 3 : Choix du type de diagramme dans l'assistant de diagramme.

Eg Remarque

Les diagrammes visibles dans les sections suivantes utilisent le type Colonne, variante Nor-
male, sans affichage en 3D.

Sélectionner les plages de données

La plage de données contient toutes les cellules comportant des données, y compris les étiquettes
et les catégories, qui doivent étre incluses dans le diagramme. Dans la page Plage de données de
I'assistant de diagramme (Figure 4), vous pouvez corriger manuellement les erreurs faites en sé-

lectionnant les données a utiliser pour le diagramme.

Assistant de diagramme

Etapes

1.Type de diagramme

.Plage de données

3.Séries de données

4.Eléments du diagramme

Choisissez une plage de données
Plage de données : |$Feuille1.$A$2:5D$8
(O Séries de données en lignes

(® Séries de données en colonnes
[]Premiére ligne comme étiquette

[IPremiére colonne comme étiquette

Sélectionner la plage de données

Figure 4 : Choix de la plage de données dans Il'assistant de diagramme.

1) Modifiez, si besoin, les lignes et colonnes contenant les données nécessaires au diagramme
en éditant les références de cellules dans le champ Plage de données. Vous pouvez le faire

de deux fagons :

— changer directement les références de la plage dans le champ,
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— cliquer sur le bouton Sélectionner la plage de données (@) a droite du champ puis sé-
lectionner directement la plage dans le classeur.

2) Spécifiez si les séries de données sont disposées en lignes ou en colonnes (comme dans
I'exemple).

3) Indiquez s'il faut utiliser la premiére ligne, la premiére colonne ou les deux comme étiquette.
4)  Cliquez sur Suivant > pour modifier les Séries de données.

5) Quand le diagramme vous satisfait, cliguez sur Terminer pour fermer l'assistant de dia-
gramme.

-#
=
—~—

Remarque

Si la syntaxe de la plage de données n’est pas correcte, Calc affiche le texte sur fond rouge.

Sélectionner des données non contigués

Pour créer une plage de données a partir de plusieurs cellules qui ne sont pas voisines l'une de
l'autre, utilisez un délimiteur entre les plages individuelles. Par exemple, les paramétres locaux
Francais (France) utilisent un point-virgule comme séparateur (c’est la virgule si la langue locale
est Anglais (USA)) et « $Feuillel.$A$2:$B$8; $Feuillel.$D$2:$D$8 » est donc une plage
de données correcte.

Le séparateur convenable dépend des parameétres locaux sélectionnés dans la page Linguistique
— Langue de la boite de dialogue Options (Outils > Options > Parameétres linguistiques >
Langues dans la barre de menu). Pour voir ou modifier le séparateur par défaut, allez a la page
LibreOffice Calc — Formule de la méme boite de dialogue (Outils > Options > LibreOffice Calc >
Formule), il se trouve dans le paramétre Ligne de matrice de la section Séparateurs.
:g Remarque
Les choix de la boite de dialogue Options ne sont pas accessibles quand le diagramme est
en cours d'édition. Si nécessaire, cliquez hors du diagramme pour quitter le mode d’édition
et accéder aux options. Cela fait, faites un double-clic dans le diagramme pour revenir au
mode d’édition.

Pour sélectionner des données non adjacentes, dans I'étape 1 précédente, effectuez une des ac-
tions suivantes :

*  saisissez manuellement les plages de données dans le champ en tapant le séparateur entre
chaque ;

+  sélectionnez, si vous ne l'avez pas déja fait, la premiere plage de données en cliguant une
premiere fois sur le bouton Sélectionner la plage de données (IEI voir Figure 4). Cliquez
une deuxiéme fois sur ce bouton et placez le curseur a la fin du champ de saisie de la petite
boite de dialogue Plage de données (sinon, la plage précédente, qui est sélectionnée, sera
effacée) et tapez le séparateur. Sélectionnez ensuite la deuxiéme partie de la plage de don-
nées.
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= Remarque

Quand les données se trouvent dans le méme document que le diagramme, les change-
ments de données sont immédiatement reflétés dans celui-ci.

Liaison avec des données externes

Calc offre plusieurs possibilités pour établir une liaison avec des données contenues dans une
source externe. Cela permet aux données (et au diagramme qui les utilise) d'étre automatique-
ment mis a jour quand elles changent. Les types suivants de fichiers peuvent étre liés : HTML,
Calc, Base, CSV, Excel et les sources de données enregistrées. Pour plus d’informations, voir le
chapitre 10, Lier les données, de ce guide.

Sélectionner les séries de données

La page Séries de données de l'assistant de diagramme autorise un paramétrage fin des données.
Chaque série de données contient un jeu de données qui ont quelque chose en commun, comme
les types d’équipement loués indiqués sur la Figure 1. Utilisez la page Séries de données pour mo-
difier la plage source de chaque série et organiser la fagon dont elles sont présentées dans le dia-
gramme. Cela inclut la suppression des données inutiles et la définition de leur disposition le long
des axes.

Organiser les séries de données

/Q\ Conseil
L'assistant de diagramme fait des suppositions sur la facon dont les données doivent étre af-
fichées, mais celles-ci peuvent ne pas étre correctes. Si un diagramme n’a pas l'aspect que

vous attendez, la premiére chose a faire est de vérifier si toutes les séries de données sont
correctement définies.

La seconde est de vérifier les parameétres de la page Plage de données qui déterminent si
les données sont disposées en lignes ou en colonnes et si la premiére ligne ou la premiére
colonne doit étre considérée comme contenant des étiquettes.

Le nom de chaque série apparait dans la liste sous Séries de données (au milieu de la Figure 5).
Pour organiser les séries de données, sélectionnez une entrée dans la liste et faites une ou plu-
sieurs des choses suivantes :

*  Pour maodifier le nom de la série, sélectionnez Nom dans la liste Plage de données a droite
puis modifiez les références de la cellule dans le champ Plage pour Nom situé en dessous
(le nom du champ s’adapte au choix précédent).

*  Pour madifier les références de la plage pour une catégorie, modifiez celles-ci dans le
champ Catégories sous la liste Plage de données.

*  Pour ajouter une nouvelle série de données sous la catégorie sélectionnée, cliquez sur le
bouton Ajouter puis définissez son nom et la plage de données correspondante comme ci-
dessus.

*  Pour supprimer la catégorie sélectionnée de la liste, cliquez sur le bouton Supprimer.
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*  Pour déplacer la catégorie sélectionnée dans la liste, cliquez sur les fleches vers le haut ou
vers le bas a droite des deux boutons précédents. L'ordre des données dans la source n’est
pas modifié, seule est changée la disposition du diagramme.

= Remarque

Des séries de données différentes doivent étre situées dans des colonnes ou des lignes sé-
parées, sinon Calc considere qu’elles forment la méme série de données.

Assistant de diagramme

- Séries de données : Plage de données :
.
Bateaux Couleur de remplissage
1.Type de diagramme Rafts Nom $'Location d"équipement'.$B%2
2.Plage de données Valeurs Y $'Location d"équipement' $B$3:9B%8
4. Eléments du diagramme Plage pour Couleur de bordure
Catégories

$'Location d"équipement’.$A$3:5A%8 =

Ajouter

Supprimer +

Personnaliser les plages de données pour des séries de données individuelles

Aide < Précédent Suivant > Annuler
N

Figure 5 : la page Séries de données de l'assistant de diagramme.

Paramétrer les plages de séries de données

Pour comprendre comment Calc traite les données dans un diagramme, il faut bien faire la distinc-
tion entre valeurs et catégories. Les valeurs sont des données numériques qui peuvent varier de
facon continue. A I'opposé, les catégories n’ont aucune relation mathématique entre elles. Par
exemple, les catégories de données dont il est question dans la Figure 5 et le diagramme de la Fi-
gure 2 sont les mois de I'année.

La plupart des diagrammes dans Calc demandent a la fois des valeurs, disposées le long de 'axe
des Y, et des catégories, disposées le long de I'axe des X. Les exceptions sont les diagrammes
XY (dispersion) et Bulles qui n'utilisent que des valeurs le long des deux axes.

Les plages de données qui peuvent étre définies pour un diagramme particulier apparaissent dans
la liste Plage de données a droite de la page Séries de données sur la Figure 5. Toutes les plages
de données n’ont pas besoin d’étre remplies. Les plages de données peuvent comporter les élé-
ments suivants.

Couleur de bordure et couleur de remplissage
Ces couleurs peuvent étre spécifiées ici par des valeurs numériques du systeme de couleurs
RVBA. Si cela n’est pas fait, Calc utilise des couleurs par défaut. On peut aussi utiliser un
formatage conditionnel qui permet de faire varier la couleur d’'un point de données selon qu’il
remplit ou non une certaine condition. Pour plus d’'information, veuillez vous reporter a « Af-
fecter des couleurs », page 27.
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Nom
Quand les séries de données sont définies en colonnes avec la premiére ligne comme éti-
guette dans la page Plage de données (Figure 4), Calc suppose que les étiquettes des co-
lonnes des données sélectionnées sont les noms des séries. Les noms des séries des don-
nées de la Figure 1 sont donc « Canoés », « Bateaux » et « Rafts ». De la méme facon, si
les données sont en ligne avec une premiére colonne contenant des étiquettes, Calc sup-
pose que celles-ci sont les noms des séries de données sélectionnées.

La seule maniére de changer le nom d’une série de données est de sélectionner Nom dans
la liste Plage de données en haut a droite de la Figure 5 puis de saisir une plage de cellules
différentes dans le champ Plage pour Nom situé sous celle-ci. Notez que le nom d’une série
de données est souvent contenu dans une cellule unique plutdt que dans une plage de cel-
lules.

Valeurs Y
Ce sont les valeurs numériques qui sont souvent disposées le long de I'axe vertical, bien que
ce ne soit pas toujours le cas. Par exemple, bien gu’elles soient disposées le long de I'axe
vertical dans les diagrammes en colonnes, elles sont placées le long de I'axe horizontal dans
les diagrammes en barres.

Catégories
La plage des données des catégories est définie dans un champ Catégories séparé sous la
liste Plage de données. Notez la différence entre les catégories et les noms des séries de
données. Pour les données de la Figure 1, les catégories sont les étiquettes des lignes alors
gue les noms des séries de données sont les étiquettes des colonnes.

= Remarque

Les catégories de données apparaissent habituellement le long de I'axe des X, sauf pour les
diagrammes XY (dispersion) et Bulles qui demandent des valeurs de données pour cet axe.

Selon le type de diagramme, d’autres plages de données peuvent devoir étre définies en plus de
celles visibles sur la Figure 5.

Définir les éléments du diagramme

Assistant de diagramme

Choisissez les parametres des titres, de la legende et de la grille

Etapes Titre [Vl Afficher la légende
" OA gauche

1.Type de diagramme pouses @A droite

2.Plage de données fm K O En_haut

3.Séries de données Axe Y

4.Eléments du diagramme Axe Z

Afficher les grilles
LIAxe X [lAxeY AxeZ

(OEn bas

Figure 6 : la page Eléments du diagramme de I'assistant de diagramme.

Dans la page Eléments du diagramme de l'assistant de diagramme (Figure 6), ajoutez ou modifiez
le titre, le sous-titre, les noms des axes et la grille. Utilisez des titres qui attirent I'attention sur le
sujet du diagramme et en décrivent le point important.
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Les éléments des graphiques en 2D et en 3D sont illustrés sur la Figure 7 :
* la paroi du diagramme délimite le graphique qui affiche les données,
* la zone du diagramme est I'arriére-plan de I'ensemble du diagramme,

+ e titre, le sous-titre, la Iégende, les étiquettes et les noms des axes sont situés dans la zone
du diagramme,

* le plancher du diagramme n’apparait que pour les diagrammes en 3D.

Titre et sous-titre du diagramme
|

Arriére-plan Nombre de locations des bateau! a moteur et autres embarcations
du diagramme
S Premier semestre 2019
Paroi du
diagramme \69\ >
) N _
50 B Canoés
0 W Bateaux
o 4
Nom de ’é’ Rafts
I'axe g 30
c
Y20
10
0 Légende
Janvier Février Mars  Auvril Mai Juin
Etiquettes Plancher du diagramme
des axes (en 3D seulement)

Figure 7 : Eléments d’un diagramme.

Pour ajouter un élément a un diagramme, effectuez une ou plusieurs des actions suivantes dans la
page Eléments du diagramme (Figure 6) :

*  Saisissez le titre et éventuellement le sous-titre dans les champs correspondants.

«  Saisissez les noms des axes X, Y et Z dans les champs convenables. Le champ Axe Z n'est
accessible que pour un diagramme en 3D.

+  Décochez I'option Afficher la Iégende (cochée par défaut) si vous ne désirez pas de légende.
Sinon, sélectionnez son emplacement (A gauche, A droite, En haut ou En bas). Les noms
qui apparaissent dans la légende sont ceux des séries de données spécifiés dans le champ
Plage pour Nom de la page Séries de données.

« Dans la section Afficher les grilles, cochez ou non les options Axe X et Axe Y pour afficher
des lignes horizontales ou verticales. Pour certains diagrammes, Axe Y est coché par défaut.
Ces options ne sont pas disponibles pour les secteurs. L'option Axe Z n’est accessible que
pour un diagramme en 3D. Pour plus d’'informations sur les grilles, veuillez vous reporter a la
section « Les grilles » page 41.
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:g Remarque
Méme apres avoir cligué sur Terminer pour refermer I'assistant de diagramme, celui-ci reste
en mode d’édition, ce qui se voit a sa bordure grise épaisse, et peut toujours étre modifié.
Cliquez dans une cellule hors du diagramme pour quitter le mode d’édition.

Modifier les parameétres d’un diagramme avec le volet latéral

L'onglet Propriétés du volet latéral (Figure 8) offre quelques options de base pour définir I'appa-
rence des diagrammes. Pour ouvrir le volet latéral, commencez par cliquer hors du diagramme
pour le désélectionner puis choisissez Affichage > Volet latéral dans la barre de menu ou ap-
puyez sur Ctr 1+F5. Par défaut, il s'ouvre sur le bord droit de I'écran.

: Propriétés : | | | Propriétés [
Zone I | — | Eléments - |
Remplir : Aucun(e) e | | Titres
A | | CTitre [1Sous-titre
] | | Légende

Transparence : Aucun v ; |
2 | Position : [Droite > |

— (o
E 0% [ I Axes '
Ombre T fx Axe X [ITitre de I'axe X [
[ Activer v]Axe ¥ [_ITitre de I'axe ¥ I
Angle - Axe Z Titre de l'axe Z
Grille

Sl N ~IMajeure horizontale [Mineure horizontale
ule No = L,

e e e _IMajeure verticale [ IMineure verticale

- Zone IF]
% | Remplir : Couleur e
Ligne [F] |
— || aucun{> |— | : l:l M
Transparence : |Aucun o
| 0% =
Transparence : |0 ° - Ligne I
Position et taille [P [ - =
|- aucun(
Position X : Position Y :
2,36 cm > 010cm =
Largeur: Hauteur :
16,00 cm +13,00 cm : 5

[“]Conserver le ratio

Disposer:

Figure 8 : L'onglet Propriétés du volet latéral quand un diagramme est sélectionné (a gauche)
et quand il est en mode d’édition (a droite).

/Q\ Conseil
Si vous avez suivi les instructions précédentes et que 'onglet Propriétés n’apparait pas, cli-

quez sur le bouton Propriétés ==/ en haut a droite du volet latéral. S’il n’apparait toujours
pas, cliquez de nouveau sur le diagramme.

Le contenu du volet latéral dépend du fait que le diagramme est sélectionné ou en mode d’édition.
L'image de gauche de la Figure 8 montre I'onglet Propriétés quand le diagramme est sélectionné
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(un seul clic, pas de bordure). Quand il est en mode d’édition (double clic, bordure grise épaisse),
son aspect est visible sur I'image de droite.

Les options qu’on y trouve sont aussi disponibles ailleurs : dans la barre de menu, dans la barre
d’outils Formatage ou dans le menu contextuel ouvert par un clic droit sur un élément du dia-
gramme.

:g Remarque

Le volet latéral peut se révéler assez utile, mais, comme les options qu’il propose se
trouvent facilement ailleurs, il n’y sera plus fait référence dans ce chapitre.

Modifier les diagrammes

L'assistant de diagramme permet de définir les caractéristiques de base d’un diagramme. Vous
pouvez avoir envie de changer les plages de données ou son apparence aprés 'avoir utilisé. Calc
offre de nombreuses possibilités pour formater et affiner 'apparence des diagrammes, dont des
outils pour modifier le type de diagramme, ses éléments, les plages de données, les polices, les
couleurs et de nombreuses autres options.

La modification d’'un diagramme se fait de deux fagons selon ce que vous voulez changer.

-« Editer les propriétés de I'objet : cliquez une fois sur le diagramme pour modifier ses proprié-
tés en tant qu’objet : la taille, la position sur la page, I'alignement, les bordures extérieures,
et aussi pour le copier, I'exporter, etc. Voyez les sections qui débutent & « Dimensionner,
déplacer et positionner un diagramme », page 57, pour plus d’informations.

«  Utiliser le mode d’'édition pour modifier la sélection de données, le type de diagramme ainsi
que les éléments tels que les axes, les titres, l'arriere-plan, les grilles, les séries de données,
les étiquettes de données, les courbes de tendance, etc.

Apercu de I'utilisation du mode d’édition

Voici quelques méthodes générales pour modifier un diagramme en mode d’édition. Elles sont pré-
sentées plus en détail dans les sections suivantes.

*  Pour ajouter un élément qui ne figure pas déja dans le diagramme, utilisez le menu Inser-
tion. Vous pouvez insérer des titres, des légendes, des noms d’'axes, des grilles, des éti-
guettes de données, des courbes de tendance, des courbes de valeurs moyennes et des
barres d’erreur.

*  Pour déplacer ou changer la taille des titres, des noms des axes, de la paroi du diagramme
et des légendes, cliquez une fois sur eux. Le curseur devient un curseur de déplacement
(son apparence exacte dépend du systéme). Tirez les éléments a leur nouvel emplacement.
Pour modifier la taille, tirez les poignées de sélection.

*  Quelques maniéres simples de modifier des éléments. Les méthodes suivantes peuvent ou-
vrir le menu ou la boite de dialogue appropriée, mais elles ne fonctionnent pas toutes pour
tous les éléments :

— faire un double clic sur un élément (voir une exception ci-dessous),

— sélectionner I'élément dans le menu Insertion (Figure 9) ou Format (Figure 10),

10 | Chapitre 3 — Créer des diagrammes et des graphiques



— cliquer une fois sur I'élément puis sur le bouton Formater la sélection == de la barre
d’outils Formatage (Figure 11),

— sélectionner un élément dans la liste déroulante Sélectionner I’élément du diagramme
puis cliquer sur le bouton Formater la sélection == qui est juste a c6té dans la barre
d’outils Formatage,

— faire un clic droit sur I'élément pour ouvrir le menu contextuel.

*  Faire un double clic sur les titres et les noms des axes pour modifier leur orthographe. Pour
les autres textes, comme les catégories, les étiquettes de données et celles de la Iégende,
modifier le texte dans les données directement dans le classeur.

*  Cliquer une fois sur un point de données (comme une colonne ou une barre) pour le sélec-
tionner et éditer la série de données associée.

* La série de données étant sélectionnée, faire un double clic sur un point de données pour
éditer ses propriétés (par exemple, sur une colonne dans un diagramme en colonnes).

Entrer en mode d’édition

Pour éditer ou formater un diagramme, faites un double clic sur celui-ci pour le placer en mode
d’édition. Il est alors entouré d’'une bordure épaisse grise. En mode d’édition, la barre de menu
change et la barre d’outils Formatage offre de nombreuses options et icobnes pour le formatage ;
elles sont présentées dans les sections suivantes.
:g Note
Les sections suivantes (jusqu’a « Dimensionner, déplacer et positionner un dia-
gramme », page 57) demandent qu’un diagramme soit en mode d’édition.

Le menu Insertion

En mode d’édition, le menu Insertion présente les options visibles sur la Figure 9.

Insertion Format Outils Fenétr
Al Titres... .
IE Legende...
b Axes..
41 Grilles...

Etiquettes des données...
Courbe de tendance
Courbes de valeur moyenne
Barres d'erreur X...

Barres d'erreur Y...
_aracteres speciaux

Figure 9 : Le menu Insertion quand un diagramme est en mode d’édition.

Titres
Ouvre une boite de dialogue ou vous pouvez saisir le titre et le sous-titre du diagramme, ain-
si que les noms des axes X, Y et Z, y compris les axes secondaires. Pour plus d’informa-
tions, voir « Titres, sous-titres et noms des axes », page 16.
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Légende

Ouvre une boite de dialogue ou vous pouvez spécifier si et ou la Iégende doit apparaitre.

Pour plus d’'informations, voir « Légende », page 18.

Axes

Ouvre une boite de dialogue ou vous pouvez choisir les axes principaux et secondaires X, Y
et Z & afficher. Pour plus d’informations, voir « Les grilles », page 41.

Etiquettes de données

Ouvre une boite de dialogue ou vous pouvez choisir d’afficher les étiquettes qui apparaissent
sur chaque point de donnée sous forme de nombres et de pourcentage, d’afficher les caté-
gories et de définir leur position et leur orientation. Pour plus d’informations, voir « Eti-

quettes de données », page 37.

Courbe de tendance

Ouvre une boite de dialogue ou vous pouvez spécifier le type de régression a utiliser, choisir
les options pour I'extrapolation, l'intersection des axes avec la courbe, son nom et I'affichage
ou non de son équation. Cette option n’est accessible que si une série de données est sélec-
tionnée. Pour plus d'informations, voir « Courbes de tendance et de valeurs moyennes »,

page 46.

Courbe de valeur moyenne

Insere une courbe de valeur moyenne pour la série de données sélectionnée ou pour toutes
les séries. Pour plus d’informations, voir « Courbes de valeur moyenne », page 50.

Barres d’erreur X et Barres d’erreur Y

Ouvre une boite de dialogue ou vous pouvez définir la catégorie d’erreur a utiliser, ses para-
meétres et les indicateurs affichés pour les valeurs positives et négatives. Pour plus d’informa-

tions, voir « Barres d’erreur », page 52.

Le menu Format

En mode d’édition, le menu Format propose les entrées visibles sur la Figure 10 et décrites ci-des-

SOus.

Format OQutils Fenétre
Titre

1h Legende...

h Axe

A1 Grille
Paroi du diagramme...

Flancher du diagramme..

Arriére-plan du diagramme...

1+ Type de diagramme...

Plages de données...

Formater la sélection...

osition et tai

Disposition

Aide

»

»

Figure 10 : le menu Format quand un diagramme est en mode d’édition.
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Titre
Ouvre une boite de dialogue qui permet la mise en forme du titre, du sous-titre ainsi que du
nom des axes. Les textes doivent d’abord avoir été saisis dans la page Eléments du dia-
gramme de l'assistant de diagramme ou en sélectionnant Insertion > Titres dans la barre de
menu.

Légende
Ouvre une boite de dialogue ou vous pouvez définir 'apparence et la position de la [égende
qui doit d’abord étre rendue visible dans la page E/éments du diagramme de I'assistant de
diagramme ou en sélectionnant Insertion > Légende dans la barre de menu.

Axe
Ouvre une boite de dialogue ou vous pouvez définir les propriétés des axes, comme I'endroit
ou ils se croisent, I'échelle des unités et le formatage de leurs étiquettes.

Grille
Ouvre une boite de dialogue qui permet de formater les grilles. Utilisez dans la page E/é-
ments du diagramme de I'assistant de diagramme ou en sélectionnant Insertion > Grilles
dans la barre de menu pour afficher ou non les grilles.

Paroi, Plancher, Arriére-plan du diagramme
Ouvre une boite de dialogue qui permet de paramétrer les bordures, le fond et la transpa-
rence de ces éléments. Notez que le plancher du diagramme n’est accessible que pour les
diagrammes en 3D. Pour plus d’informations, voir « Formater I’arriére-plan d’un dia-
gramme », page 20.

Type de diagramme
Ouvre une boite de dialogue ou vous pouvez changer le type de diagramme et choisir entre
la 2D et la 3D. Les divers types de diagrammes sont présentés dans la « Galerie de types
de diagrammes » qui commence page 65.

Plages de données
Ouvre une boite de dialogue qui vous permet de définir les plages de toutes les données du
diagramme et les séries de données, comme expliqué dans « Sélectionner les plages de
données », page 3, et « Sélectionner les séries de données », page 5.

Affichage 3D
Ouvre une boite de dialogue qui vous permet de paramétrer la perspective, I'éclairage et
I'aspect d’'un diagramme en 3D. Notez que cette entrée de menu n’est accessible que pour
les diagrammes en 3D, qui ne sont possibles que pour les colonnes, les barres, les secteurs
et les zones. Pour plus d’informations, voir « Diagrammes en 3D », page 43.

Formater la sélection
Ouvre une boite de dialogue ol vous pouvez paramétrer I'élément sélectionné : remplissage,
bordures, positionnement, transparence, police, étiquettes, échelles et autres attributs.

Position et taille
Ouvre une boite de dialogue ou vous pouvez définir de fagon précise la position de I'élément
sélectionné dans le diagramme et sa taille. Pour plus d’'informations, voir « La boite de dia-
logue Position et taille », page 58.
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Disposition
Offre deux possibilités : Envoyer vers I'avant ou Envoyer vers lI'arriére. Il se peut qu’'une
seule des deux soit active pour certains éléments. Elles permettent de gérer le recouvrement
des séries de données.

La barre d’outils Formatage

En mode d’édition d’'un diagramme, la barre d’outils Formatage prend I'aspect visible sur la Figure
11. Cliquez sur une des icones pour ouvrir une boite de dialogue, ou activer ou désactiver une op-
tion. Les entrées des menus Insertion et Format décrits ci-dessus offrent les mémes options, a
une exception pres.

s A bk 8 0T oo | alofbln bl alo ok
4

: il I

g?”e‘:'”d'ag'amme 112 3 5 6 7 8 9 10 11 12 13 14 15 16 17
iagramme : : . .

_|Paroi du diagramme I E I F I G | H I | J | K |

Plancher du diagramme Premier semestre 2019
Légende |
Titre principal

Sous-titre
Axe X
Axe X de la grille principale MCMOCS
. B Bateaux
Axe Y
Titre de l'axe Y Rafts
Axe Y de la grille principale
Axe 7
Séries de données 'Canoés'
Séries de données 'Bateaux’
Séries de données 'Rafts'
0
Janvier  Février Mars Avril Mai Juin
1. Liste des éléments 2. Formater la sélection 3. Type de diagramme
4. Arriére-plan du diagramme | 5. Paroi du diagramme 6. Affichage 3D
7. Plages de données 8. Table de données 9. Titres
10. Afficher/masquer la Iégende |11. Légende 12. Grille horizontale
13. Grille verticale 14. Axe X 15. Axe Y
16. Axe Z 17. Tous les axes

Figure 11 : La barre d’outils Formatage quand un diagramme est en mode d’édition.

La liste de sélection des éléments du diagramme n’apparait nulle part ailleurs. Utilisez-la pour sé-
lectionner facilement les éléments du diagramme, ce qui peut se révéler particulierement utile
guand il est surchargé ou qu'il est difficile de faire cette sélection avec le pointeur de la souris. No-
tez que des choix tels que Etiquettes de données ou Courbe de tendance n'y apparaissent pas
a moins d’'avoir déja été ajoutés grace au menu Insertion.

o~

:g Rappel

Les sections suivantes (jusqu’a « Dimensionner, déplacer et positionner un dia-
gramme », page 57) demandent qu’un diagramme soit en mode d’édition.
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Sélectionner et déplacer les éléments d’un diagramme

Sélection

Apres avoir placé le diagramme en mode d’édition par un double clic sur celui-ci, sélectionnez ses
éléments grace a une des méthodes suivantes :

*  cliguez une fois sur I'élément (pour sélectionner un point de données individuel, cliquez une
deuxiéme fois, mais pas trop vite (ce n'est pas un double-clic) aprés avoir cliqué une fois
pour sélectionner la série de données).

*  sélectionnez I'élément dans la liste déroulante située a gauche de la barre d'outils Forma-
tage (Figure 11).

Une fois sélectionné, I'élément est encadré de poignées de sélection carrées.
N, g
/Q\ Conseil

Quand le pointeur de la souris survole un élément, Calc affiche alors son nom, ce qui per-
met de voir s'il s’agit bien de I'élément souhaité. Ce nom apparait aussi dans la barre d’état.

Déplacement

Vous désirerez peut-étre déplacer certains éléments d’'un diagramme indépendamment des autres,
par exemple pour repositionner le titre ou le nom des axes. Pour cela :

1) Sélectionnez I'élément comme décrit ci-dessus.

2) Le curseur change de forme pour indiquer un déplacement (son apparence exacte dépend
des parameétres de I'ordinateur).

3) Tirez I'élément en maintenant I'appui sur le bouton gauche de la souris pendant le déplace-
ment.

4)  Relachez le bouton quand I'élément a atteint son emplacement désiré.
Vous pouvez aussi utiliser la boite de dialogue Position et taille comme décrit page 58.

Ni les points de données individuels, ni les séries de données ne peuvent étre déplacés, a I'excep-
tion des secteurs. Les secteurs d’'un disque peuvent étre déplacés individuellement ou le disque
entier peut étre explosé. Voir « Diagrammes en secteurs », page 67, pour plus d’informations.

Pour déplacer les étiquettes des axes, voir « Positionner les axes, les étiquettes et les
marques d’intervalles », page 32. Pour déplacer les étiquettes de données, voir « Ajouter des
étiquettes a une série de données et les formater », page 37.

N\, 7
’Q‘ Conseil
Pour certains éléments du diagramme (comme les titres, les sous-tires, les noms des axes

et la Iégende), vous pouvez appuyer sur les touches fléchées du clavier pour déplacer I'objet
par petits pas.
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:g Remarque
Quand un élément de diagramme en 3D est sélectionné, des poignées de sélection rondes
peuvent apparaitre. Elles contrélent I'angle de perspective de I'élément. Il est impossible de
déplacer ou de redimensionner I'élément tant qu’elles sont visibles. Cliguez de nouveau
pour retrouver les poignées carrées qui permettent le déplacement et le redimensionnement
du dessin du diagramme en 3D.

Changer de type de diagramme

Pour changer de type de diagramme (barres, colonnes, lignes, secteurs, etc.) :

1) Sélectionnez le diagramme par un double clic sur celui-ci pour entrer en mode d’édition. Il
doit étre entouré d’'une bordure épaisse grise.

2) Ouvrez la boite de dialogue Type de diagramme par I'une des méthodes suivantes :
— sélectionnez Format > Type de diagramme dans la barre de menu,
— cliquez sur I'icéne Type de diagramme | x4 dans la barre d’outils Formatage,

— faites un clic droit sur le diagramme et sélectionnez Type de diagramme dans le menu
contextuel.

La boite de dialogue est semblable a la premiéere page de I'assistant de diagramme visible a
la Figure 3, page 3.

3) Sélectionnez le type de diagramme et la variante souhaitée.

4)  Cliquez sur OK pour refermer la boite de dialogue. Si nécessaire, cliquez hors du dia-
gramme pour quitter le mode d’édition.

Pour plus d'information sur les types de diagrammes, veuillez vous reporter a la « Galerie de
types de diagrammes », page 65.

Titres, sous-titres et noms des axes

Créer ou modifier le texte
Pour créer ou modifier le texte du titre, du sous-titre ou du nom d’'un axe du diagramme :

1) Sélectionnez le diagramme par un double clic sur celui-ci pour entrer en mode d’édition. Il
doit étre entouré d’'une bordure épaisse grise.

2) Ouvrez la boite de dialogue Titres (Figure 12) par I'une des méthodes suivantes :
— Sélectionnez Insertion > Titres dans la barre de menu.
— Cliquez sur l'icone Titres 1li dans la barre d’outils Formatage.

— Faites un clic droit sur le diagramme et sélectionnez Insérer des titres dans le menu
contextuel.

3) Saisissez ou modifiez le texte dans les champs de saisie appropriés.
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4)

Cliquez sur OK pour refermer la boite de dialogue. Si nécessaire, cliquez hors du dia-
gramme pour quitter le mode d’édition.

:Q/_ Astuce

5)

Le texte d’un titre (mais pas son formatage) peut étre modifié sur place. Cliqguez une fois sur
le titre du diagramme en mode d’édition pour faire apparaitre les poignées de sélection.
Faites un double-clic a I'intérieur de celles-ci pour faire apparaitre le curseur de texte cligno-
tant et pouvoir modifier le contenu du titre. A la fin d’une ligne, appuyez sur Maj+Entrée
pour créer une ligne supplémentaire.

Cliquez sur OK pour refermer la boite de dialogue. Si nécessaire, cliquez hors du dia-
gramme pour quitter le mode d’édition.

Titre

Sous-titres

Axes secondaires

Axe X
Axe Y

Aide Annuler

Figure 12 : La boite de dialogue Titres

Formater le texte

La mise en forme de I'apparence d'un titre, d’'un sous-titre ou du nom des axes du diagramme uti-
lise une boite de dialogue plus compléte. Pour y accéder :

1)

2)

Sélectionnez le diagramme par un double clic sur celui-ci pour entrer en mode d’édition. I
doit étre entouré d’une bordure épaisse grise.

Ouvrez la boite de dialogue Titres (Figure 13) par I'une des méthodes suivantes :
— Sélectionnez Format > Titre puis le type de titre désiré dans la barre de menu.

— Cliquez sur I'élément dans le diagramme pour le sélectionner puis faites un clic droit sur
celui-ci et sélectionnez Formater le titre (ou I'élément sélectionné) dans le menu contex-
tuel.

— Cliquez sur I'élément dans le diagramme pour le sélectionner, choisissez I'élément dans
la liste déroulante de la barre d’outils Formatage puis cliquez sur le bouton Formater la
sélection ou sélectionnez Format > Formater la sélection dans la barre de menu.
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Titres

BorduresZone Transparence Police Effets de caractére Alignement
Propriétés de ligne
Style :
'— aucun(e)- o
Couleur :

Noir

@
(1]

o =

Figure 13 : La boite de dialogue de formatage des titres.
3) Formatez le texte a votre godt. Les choix possibles sont explicites et I'aide facile a trouver.

4)  Cliquez sur OK pour refermer la boite de dialogue. Si nécessaire, cliquez hors du dia-
gramme pour quitter le mode d’édition.

Légende

Quand elle est affichée, une Iégende montre les noms des séries de données associés a leurs re-
présentations graphiques, barres, lignes ou points. Elle présente aussi les courbes de tendance
actives comme le montre la Figure 14.

—@i— Canoés —— Logarithmique (Canoés) =-e= Bateaux Moyenne (Bateaux)
Rafts == Vélos =—p— Tricycles

Figure 14 : Exemple de légende placée en bas d’un diagramme.

Positionner, insérer et supprimer une légende

Insertion ou suppression seule
Pour seulement insérer ou supprimer une légende :

1) Sélectionnez le diagramme par un double clic sur celui-ci pour entrer en mode d’édition. Il
doit étre entouré d’'une bordure épaisse grise.

2) Effectuez I'une des actions suivantes :

— Cliquez sur l'icone Afficher/masquer la légende | dans la barre d’outils Formatage.
Par défaut, la Iégende est insérée a droite du diagramme.

— Faites un clic droit sur le diagramme et sélectionnez Insérer la Iégende ou Supprimer la
Iégende dans le menu contextuel.

3) Sinécessaire, cliquez hors du diagramme pour quitter le mode d'édition.
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Remarque

Les noms qui apparaissent dans la légende sont ceux des séries de données définis d’aprés
les plages de données comme exposé dans « Paramétrer les plages de séries de don-
nées », page 6. Pour les modifier, changez le texte directement dans le classeur.

Positionnement et insertion ou suppression

Pour positionner une légende en l'insérant, ou pour la supprimer, utilisez la boite de dialogue Lé-
gende (Figure 15) en appliguant la méthode ci-dessus et en remplacant I'étape 2 par les sui-
vantes :

1)

2)
3)

4)

N, 4
/Q\

Sélectionnez Insertion > Légende dans la barre de menu pour ouvrir la boite de dialogue
Légende.

Cochez ou décochez 'option Afficher la Iégende selon le cas.

Sélectionnez I'emplacement souhaité pour la légende (A gauche, A droite, En haut ou En
bas).

Cliquez sur OK pour refermer la boite de dialogue. Si nécessaire, cliquez hors du dia-
gramme pour quitter le mode d’édition.

Position
[|Afficher la légende:
OA gauche
O A droite
(O En haut

®En bas

Figure 15 : la boite de dialogue Légende

Conseil

Pour un placement plus précis de la légende, utilisez une des méthodes décrites dans « Dé-
placement », page 15.

Formater la Iégende

Pour modifier 'apparence de la Iégende, une boite de dialogue plus compléte offre plusieurs op-
tions pour formater les bordures, I'arriére-plan, la police, la transparence et la position.

1)

2)

Sélectionnez le diagramme par un double clic sur celui-ci pour entrer en mode d’édition. Il
doit étre entouré d’une bordure épaisse grise.

Ouvrez la boite de dialogue Légende (Figure 16) par I'une des méthodes suivantes :
— Cliquez sur I'icéne Légende |1;; dans la barre d’outils Formatage.
— Sélectionnez Format > Légende dans la barre de menu.

— Cliguez sur la Iégende dans le diagramme pour le sélectionner puis faites un clic droit sur
celle-ci et sélectionnez Formater la Iégende dans le menu contextuel.
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— Seélectionnez Légende dans la liste déroulante de la barre d’outils Formatage puis cliquez
sur le bouton Formater la sélection = .

Bordures Zone Transparence Police Effets de caractére Disposition
Propriétés de ligne

Style :

Couleur :

#B3B3B3 >

Largeur :
000cm %

Transparence :
-

0% -

Figure 16 : La boite de dialogue Légende avec les options de formatage.

3) Effectuez les modifications désirées. Les choix possibles sont explicites ou I'aide facile a
trouver.

4)  Cliquez sur OK pour refermer la boite de dialogue. Si nécessaire, cliquez hors du dia-
gramme pour quitter le mode d’édition.

Formater l'arriére-plan d’un diagramme

L'arriére-plan d’'un diagramme est partagé en trois zones : le fond (la zone) du diagramme, sa pa-
roi et son plancher, comme on le voit sur la Figure 7, page 8. Le paramétrage des bordures, du
fond et de la transparence de ces zones peut étre effectué de la fagon suivante :

1)

2)

Sélectionnez le diagramme par un double clic sur celui-ci pour entrer en mode d’édition. Il
doit étre entouré d’'une bordure épaisse grise.

Ouvrez la boite de dialogue approprié (Figure 17 par exemple) par 'une des méthodes sui-
vantes :

— Dans le menu Format, sélectionnez Paroi du diagramme, Plancher du diagramme ou
Arriére-plan du diagramme.

— Cliquez sur la paroi, le plancher ou l'arriere-plan du diagramme pour le sélectionner puis
faites un clic droit sur celui-ci et sélectionnez Formater la paroi, Formater le plancher
ou Formater la zone du diagramme dans le menu contextuel.

— Cliquez sur l'icdne Arriére-plan du diagramme 1 ou Paroi du diagramme 11 dans la
barre d’outils Formatage (il n’y a pas d’'icéne pour le plancher).

— Sélectionnez Zone du diagramme, Paroi du diagramme ou Plancher du diagramme
dans la liste déroulante de la barre d’outils Formatage puis cliquez sur le bouton Forma-
ter la sélection = .
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Zone du diagramme

Bordures Zone Transparence

Mode Zone de transparence

(O Pas de transparence

(OTransparence :

Type : |Axial
Centre X : |50 %
Centre Y: |50 %

Angle : |0°
Bordure : |0 %

A L4y ] 4 <>|<

Valeur initiale : |0 %

Valeur finale : 100 %

LI 3

Figure 17 : I'onglet Transparence de la boite de dialogue Zone du diagramme.

3) Formatez I'élément choisi a votre godt. Les choix possibles sont explicites ou l'aide facile &
trouver.

4)  Cliquez sur OK pour refermer la boite de dialogue. Si nécessaire, cliquez hors du dia-
gramme pour quitter le mode d’édition.

Plages et séries de données

La raison d’'étre d'un diagramme est de présenter clairement une ou plusieurs séries de données
et Calc offre un certain nombre de fagons de définir et présenter ces données. Les sections qui
suivent présentent des sujets comme la définition et la modification des plages de données, leur
alignement sur un axe Y secondaire et la mise en forme de I'apparence des séries de données.

Modifier les plages de données

Quand les plages de données changent dans le classeur, modifiez les parametres du diagramme
pour refléter ces changements. Pour cela, utilisez une des méthodes suivantes.

Eg Remarque

Le diagramme refléte automatiquement les changements des données du classeur. Ainsi,
changer un 5 en 50 dans les données sera immédiatement visible dans le diagramme.

Remplacer les données par tirer-glisser

Il est facile de remplacer a la main un ensemble de données par un autre. Faites-le de la maniere
suivante :

1) Utilisez la souris pour sélectionner toutes les nouvelles données.

2) Tirez les données sur le diagramme puis relachez le bouton de la souris. Le dialogue visible
a la Figure 18 s’ouvre.
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3)

Précisez si la premiére ligne et la premiére colonne contiennent ou non des étiquettes puis
cliquez sur OK.

Modifier la plage de données... X

Etiquettes

[JPremiére colonne comme étiquette

[“IPremiére ligne comme étiquette

Aide Annuler

Figure 18 : la boite de dialogue Modifier la plage de données source.

Modifier la plage et les séries de données

Pour modifier la plage d’'une série de données, faites ceci :

1)

2)

3)

4)

5)

Sélectionnez le diagramme par un double clic sur celui-ci pour entrer en mode d'édition. Il
doit étre entouré d’'une bordure épaisse grise.

Ouvrez la boite de dialogue Plages de données par 'une des méthodes suivantes :
— Sélectionnez Format > Plages de données dans la barre de menu.
— Cliquez sur I'icéne Plages de données |- dans la barre d’outils Formatage.

— Faites un clic droit sur le diagramme et sélectionnez Plages de données dans le menu
contextuel.

Modifiez la plage de données dans I'onglet Plage de données qui est semblable a la page
Plage de données de I'assistant de diagramme (Figure 4, page 3).

Modifiez les séries de données dans I'onglet Séries de données qui est semblable a la page
Séries de données de I'assistant de diagramme (Figure 5, page 6).

Cliquez sur OK pour refermer la boite de dialogue. Si nécessaire, cliquez hors du dia-
gramme pour quitter le mode d’édition.

Pour plus d'information, veuillez vous reporter a « Sélectionner les plages de données », page 3
et a « Sélectionner les séries de données », page 5.

/Q‘ Conseil

Si Calc prend un temps significativement long pour traiter une grande quantité de données
pour un diagramme, essayez ceci : ne sélectionnez que quelques données de chaque série
pour créer la disposition initiale de votre diagramme. Ajustez les réglages jusqu’a obtenir
I'effet désiré puis sélectionnez toutes les données.

Ouvrir la boite de dialogue Séries de données

La boite de dialogue Séries de données offre plusieurs options pour présenter les données dans le
diagramme. Notez qu’une seule série de données peut étre sélectionnée a la fois.

Pour ouvrir la boite de dialogue Séries de données :

1)

Sélectionnez le diagramme par un double clic sur celui-ci pour entrer en mode d’édition. I
doit étre entouré d’'une bordure épaisse grise.
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2) Seélectionnez la série de données par I'une des méthodes suivantes :
— Cliguez sur la série de données dans le diagramme.

— Cliguez sur le nom de la série de données dans la liste déroulante de la barre de Forma-
tage.

3) Pour ouvrir la boite de dialogue Séries de données, effectuez I'une des actions suivantes :
— Sélectionnez Format > Formater la sélection dans la barre de menu.
— Cliguez sur I'icdne Formater la sélection dans la barre d’outils Formatage.

— Faites un clic droit sur le diagramme et sélectionnez Formater les séries de données
dans le menu contextuel.

4)  Cliquez sur 'onglet approprié pour effectuer les modifications souhaitées. Les options de
chaque onglet sont présentées ci-dessous.

5) Cliquez sur OK pour refermer la boite de dialogue. Si nécessaire, cliguez hors du dia-
gramme pour quitter le mode d’édition.

= Remarque

Les paramétres qui apparaissent dans I'onglet Options de la boite de dialogue Séries de
données dépendent du type de diagramme sélectionné.

Alignement, espacement et options de tracé

Aligner des données sur I’axe Y secondaire

Un axe secondaire peut étre utile quand les unités ou les étendues ne sont pas les mémes pour
toutes les séries de données, comme sur la Figure 19. Dans ce cas, une des séries (Rafts) com-
porte des valeurs significativement plus grandes que les autres. Pour tracer les trois séries sur le
méme diagramme, la série de données Rafts est alignée sur un axe secondaire qui a une plus
grande étendue. La couleur de cet axe et son titre aide a souligner leur relation.

Nombre de locations

35+ 120
307 . 100
25+
x 4 80 )
3 == Canoés
% 201 " —4— Bateaux
e 60 5 Rafts
o 15+ 14
D
g 40
8 104
5 20
0= 0
Janvier Février Mars Auvril Mai Juin

Figure 19 : Série de données alignée sur un axe Y secondaire.
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= Remarque

Une série de données ne peut étre associée a un axe Y secondaire qu'apres la fermeture de
I'assistant de diagramme et la fin de la création du diagramme.

Pour aligner une série de données sur un axe Y secondaire :

1) Sélectionnez la série de données et ouvrez la boite de dialogue Séries de données comme
décrit dans la section précédente (page 22).

2) Dans la section Aligner les séries de données a de 'onglet Options, cochez Axe Y secon-
daire (Figure 20).

3) Cliguez sur OK pour refermer la boite de dialogue. Si nécessaire, cliguez hors du dia-
gramme pour quitter le mode d’édition.

Les données ne peuvent étre alignées que sur un axe secondaire Y, pas sur un axe secondaire X.
Il est cependant possible de créer des axes secondaires X et Y qui reproduisent les axes primaires
de l'autre c6té du diagramme. Cette opération est décrite dans « Ajouter ou supprimer les éti-
quettes des axes », page 29. Il est aussi possible d’afficher des unités ou des étendues diffé-
rentes sur les axes secondaires (avec ou sans y aligner des données), comme décrit a « Définir
I’échelle », page 31.

Espacement et options de tracé

L'onglet Options de la boite de dialogue Séries de données (Figure 20) offre des parametres sup-
plémentaires qui dépendent du type de diagramme.

Séries de données »

Options Zone Transparence Bordures

Ali I aries de données a

O Axe Y secondaire
Options de tracé
Tracer les valeurs manquantes aisser un espace

®) Supposer zéro

O Continuer la courbe
[inclure les valeurs des cellules masquées
Legende

[ Exclure cette entrée de la légende

Figure 20 : I'onglet Options de la boite de dialogue Séries de données.

Espacement
Ce champ définit I'intervalle entre les groupes de barres ou de colonnes qui correspondent a
une méme valeur de la catégorie. Une valeur supérieure a 100 % augmente I'espacement
(maximum 600 %) et une valeur inférieure & 100 % le diminue.

Chevaucher
Ce champ définit le recouvrement des barres ou des colonnes correspondant a une méme
valeur de la catégorie. Plus le pourcentage est élevé (maximum 100 %), plus le chevauche-
ment est important. Les pourcentages négatifs créent une séparation entre les barres ou les
colonnes du méme groupe (minimum -100 %).
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Afficher les barres cote a cote
Quand cette option est cochée, il n'y a aucun écart entre les colonnes ou les barres dans l'in-
tervalle entre les catégories. Si elle n’est pas cochée, les données alignées sur un axe Y se-
condaire peuvent masquer les autres. Cochez cette option pour I'éviter.

Tracer les valeurs manquantes
Ces options précisent la gestion des valeurs manquantes avec des choix qui dépendent du
type de diagramme.

Inclure les valeurs des cellules masquées
Cette option indique s'il faut afficher ou non les valeurs des cellules masquées.

Exclure cette entrée de la Iégende
Cette option permet d’inclure ou non le nom de la série de données choisie de la Iégende.

Deux options supplémentaires (non visibles sur la Figure 20) apparaissent pour les diagrammes
en secteurs ou en tores ;

Orientation
Cette option précise I'ordre des secteurs (points de données) : dans le sens des aiguilles
d’'une montre (valeur par défaut) ou le sens inverse.

Angle de départ
Ce champ spécifie I'angle de départ du premier secteur (point de données) entre 0 et 359°.
Tirez le point a la périphérie du cercle ou saisissez un nombre de degrés. 0 degré fait com-
mencer la premiére section a 3 heures et 90° a 12 heures.

Zone, transparence et bordures

Séries de données

Options Zone Transparence Bordures

Aucun Couleur Dégradé Bitmap Motif Hachures

Dégrade Options Apercu
A Iype:
Radial &

Incrément :
Automatique

Centre (X/Y):

50 % 1[50 % .
."r\Ul__,'lL_' 2|0°

Bordure :

| 0% |2

Couleur d'origine :

| Vert clair 4 v 100%

OElm
I
HLORE

¥ Couleur de destination :
Ajouter | Modifier Vert clair 2 ¥ 100 %

Figure 21 : I'onglet Zone de la boite de dialogue Séries de données.
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Pour les types de diagrammes autres que ligne et dispersion, la boite de dialogue Séries de don-
nées propose des onglets pour mettre en forme le fond et les bordures de la représentation gra-
phigue, comme les colonnes ou les barres. L'onglet Zone (Figure 21) offre la possibilité de choisir
une couleur dans une palette, d’ajouter une palette personnalisée ou de la définir par ses valeurs
de rouge, vert et bleu ou son code hexadécimal. Il est aussi possible d'utiliser des dégradés, des
images, des motifs ou des hachures. Deux autres onglets reglent la transparence et les bordures.
Leurs options sont explicites et I'aide se trouve facilement.

/Q\ Astuce
Si le dégradé que vous avez paramétré ne fonctionne pas comme vous l'attendez, cliquez
sur Ajouter, donnez-lui un nom (ou acceptez le nom par défaut) et cliguez sur OK.

Lignes, zones et icbnes des points de données

Pour les diagrammes de type ligne ou dispersion, la boite de dialogue Séries de données n’'offre
qgu'un onglet Ligne en plus de I'onglet Options (Figure 22).

Séries de données

Options Ligne

Propriétés de ligne

Style : . B Continu e

Couleur : B #FFa20E N =
Large =

Largeur : 0,08 cm =

Hauteur

4 r 4

Transparence: 0%

Conserver le ratio

/NN

Figure 22 : L'onglet Ligne de la boite de dialogue Séries de données
pour les diagrammes de type ligne et dispersion.

Spécifiez le style de ligne, sa couleur, sa largeur et sa transparence dans la section Propriétés de
la ligne & gauche de la boite de dialogue.

Dans la section Icone, faites votre choix parmi les options Pas de symbole, Automatique, A par-
tir d’un fichier, Galerie et Symboles.

« A partir d’un fichier ouvre une boite de dialogue ol vous pourrez sélectionner le fichier qui
contient le symbole désiré.

*  Galerie ouvre une liste des graphismes disponibles ou vous pourrez choisir celui qui vous
convient.

*  Symboles ouvre une liste des symboles disponibles ou vous pourrez faire votre choix.

Cochez ou non I'option Conserver le ratio pour maintenir ou non le rapport d’aspect du symbole
pendant que vous saisissez sa largeur et sa hauteur.
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En bas de la boite de dialogue, une zone d’apercu vous montre le résultat des choix que vous
avez effectués.

Affecter des couleurs

Des couleurs d’'affichage des séries de données peuvent étre spécifiées de trois fagons : en chan-
geant le schéma de couleurs par défaut, en utilisant la boite de dialogue Séries de données ou en
utilisant les plages de données pour définir les couleurs de bordure et de remplissage.

Modifier le schéma de couleurs par défaut

Pour modifier le schéma de couleurs par défaut, ouvrez la page Diagramme — Couleurs par défaut
de la boite de dialogue Options (Outils > Options > Diagramme > Couleurs par défaut dans la
barre de menu) ou vous pouvez définir la couleur de 12 séries de données. Les modifications ef-
fectuées a cet endroit affecteront les couleurs par défaut de tous les diagrammes a venir.

Avec la boite de dialogue Séries de données

Comme expliqué dans la section précédente, la boite de dialogue Séries de données offre des op-
tions pour affecter des couleurs aux lignes, surfaces et bordures. Les options disponibles dé-
pendent du type de diagramme.

Utiliser les plages de données pour affecter des couleurs

Utilisez la fonction COULEUR de I'assistant Fonctions (décrit au chapitre 7, Utiliser les formules et
les fonctions) pour définir les couleurs par des nombres calculés a partir des valeurs de rouge, vert
et bleu, puis affecter ces nombres aux couleurs de bordure et de remplissage dans l'onglet Séries
de données de I'assistant de diagramme (voir « Organiser les séries de données » page 5) ou
dans I'onglet de méme nom de la boite de dialogue Plages de données (voir « Modifier la plage
et les séries de données » page 22). Une couleur, la méme pour toutes ou des couleurs diffé-
rentes, doit étre affectée a chaque valeur de la plage.

Par exemple, apres avoir sélectionné la fonction COULEUR dans I'assistant Fonctions, saisissez
255 pour Rouge, 0 pour Vert et 255 pour Bleu. La fonction calcule la valeur RVB qui est 16711935.
Ensuite, quand vous définissez les plages de données, entrez les cellules qui contiennent cette va-
leur pour la couleur de remplissage et de bordure. Vous pouvez, en plus, inclure, dans la fonction
COULEUR, une valeur pour le canal Alpha entre 0 (totalement transparent) et 255 (totalement
opaque).
:g Remarque
Les couleurs de remplissage et de bordures ne peuvent étre spécifiées pour les plages de
données que pour les diagrammes en colonnes, en barres, en secteurs, en bulles et en co-
lonnes et lignes.

En plus d'affecter directement des couleurs, vous pouvez utiliser le formatage conditionnel quand
des couleurs spécifiques doivent étre utilisées (le formatage conditionnel est décrit dans le chapitre
2, Saisir, éditer et formater les données).

La Figure 23 montre un exemple d’utilisation du formatage conditionnel. La fonction COULEUR est
utilisée pour créer la formule conditionnelle
=SI(B2>100;COULEUR(240;240;;20);COULEUR(150;0;150;20)).
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67 viifx ¥ = =51(B2>100; COULEUR(240;240;;20); COULEUR(150;0;150;20))

A B e D E F G
1 | Température Nombre Couleur

20 67| 345374870

25 76 345374870

120
100

3 | 3
4 30 90 345374870 5 90
5 | 35 101 351334400 g 60
6 40 111 351334400 40
E 45 106 351334400 20
88 50 08 345374870 0
- 29 87 345374870 20 25 30 35 40 45 50 55
1 10 | Température

Figure 23 : Utilisation de la fonction COULEUR et
d’une formule conditionnelle pour définir la couleur.

Cette formule spécifie que, si la valeur dans la colonne B est supérieure a 100, la couleur utilisée
est définie par la fonction COULEUR(240;240; ;20), sinon elle est définie par la fonction
COULEUR(150;0;150;20). Cette formule est copiée dans les cellules de C2 & C9. Les nombres
qui s’y trouvent sont les valeurs RVB calculées en utilisant cette formule a partir de références de
cellules adaptées a chaque ligne et qui sont utilisées, comme expliqué ci-dessous pour définir les
couleurs de la série de données. Le diagramme montre le résultat obtenu.

Formater les points de données

Pour modifier 'apparence d'un point de donnée particulier utilisez la boite de dialogue Point de
données. Pour la plupart des types de diagrammes, elle contient les mémes onglets Zone, Trans-
parence et Bordures que la boite de dialogue Séries de données visible sur la Figure 21, page 25.
Pour les diagrammes Ligne et Dispersion, ce sont les mémes options que sur la Figure 22, page
26.

Pour formater un point de donnée :

1) Sélectionnez le diagramme par un double clic sur celui-ci pour entrer en mode d’édition. Il
doit étre entouré d’'une bordure épaisse grise.

2) Sélectionnez le point de données a formater en cliquant deux fois sur lui (pas trop vite, ce
n’est pas un double-clic).

3) Pour ouvrir la boite de dialogue Point de données pour les séries de données ..., effectuez
I'une des actions suivantes :

— Sélectionnez Format > Formater la sélection dans la barre de menu.
— Cliquez sur I'icéne Formater la sélection dans la barre d’outils Formatage.

— Faites un clic droit sur le diagramme et sélectionnez Formater le point de données dans
le menu contextuel.

4)  Appliquez la mise en forme souhaitée.

5) Cliquez sur OK pour refermer la boite de dialogue. Si nécessaire, cliguez hors du dia-
gramme pour quitter le mode d’édition.
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15 Point de données 1, séries de données 2, valeurs : Janvier 23
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Rafts
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20

Juin

Figure 24 : Infobulle donnant des informations sur un point de données.

_:g_ Astuce

Comme on le voit sur la Figure 24, quand le pointeur de la souris survole un point de don-
nées (en mode d'édition), une infobulle affiche le numéro du point de données, celui de sa

série ainsi que ses valeurs X et Y.

Les axes

Ajouter ou supprimer les étiquettes des axes

Utilisez la boite de dialogue Axes visible sur la Figure 25 pour ajouter ou supprimer les étiquettes
des axes, comme les nombres ou les catégories. (Pour modifier le nom d’'un axe, voir « Titres,
sous-titres et noms des axes », page 16.)

Axes Axes secondaires
MAxe X CAxe X
Axe Y [JAxe Y
Axe £

Aide Annuler

Figure 25 : la boite de dialogue d’affichage des axes.

Pour utiliser la bofite de dialogue Axes :

1)

2)

Sélectionnez le diagramme par un double clic sur celui-ci pour entrer en mode d’édition. Il

doit étre entouré d’'une bordure épaisse grise.

Ouvrez la boite de dialogue Axes, en effectuant 'une des actions suivantes :

— Sélectionnez Insertion > Axes dans la barre de menu.
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— Faites un clic droit sur le diagramme et sélectionnez Insérer/supprimer des axes dans le
menu contextuel.

3) Cochez ou décochez les options pour les axes concernés. L'option Axe Z ne peut étre co-
chée que si le diagramme est en 3D.

4)  Cliquez sur OK pour refermer la boite de dialogue. Si nécessaire, cliquez hors du dia-
gramme pour quitter le mode d’édition.

Janvier Février Mars Avril Mai Juin
60 60
50 50
40 40
30 30
20 20
T ad:

0 0
Janvier Février Mars Avril Juin

Figure 26 : Les deux axes secondaires sont activés.

Sélectionner un axe secondaire X ou Y dans cette boite de dialogue duplique les étiquettes de
l'autre c6té du diagramme, comme on le voit sur la Figure 26. Pour spécifier des unités ou des in-
tervalles différents pour 'axe secondaire, utilisez I'onglet Echelle de la boite de dialogue de forma-
tage des axes décrite dans la section suivante.

Il est aussi possible d’aligner une ou plusieurs séries de données sur I'axe Y secondaire, en utili-
sant la boite de dialogue Séries de données, comme décrit dans « Aligner des données sur I’axe
Y secondaire », page 23.

Modifier et formater les axes

En supplément de la boite de dialogue simple précédente, une boite de dialogue Axes plus com-
plete offre des options pour définir les intervalles de la grille, la position des axes, le formatage de
la ligne et des étiquettes ainsi que I'échelle, entre autres choses. Utilisez une boite de dialogue
pour un axe précis ou celle qui s’applique a tous les axes. Les options proposées dépendant de
I'axe sélectionné, du type de diagramme et du choix d'un diagramme en 2D ou en 3D.

Pour ouvrir la boite de dialogue de formatage des axes :

1) Sélectionnez le diagramme par un double clic sur celui-ci pour entrer en mode d’édition. Il
doit étre entouré d’'une bordure épaisse grise.

2) Ouvrez la boite de dialogue pour un axe précis, en effectuant I'une des actions suivantes
(certaines options ne permettent pas de choisir tous les axes) :

— Sélectionnez Format > Axes dans la barre de menu et sélectionnez I'axe désiré (Axe X,
Axe Y, Axe Z, Axe X secondaire, Axe Y secondaire ou Tous les axes).

— Faites un clic droit sur I'axe désiré et sélectionnez Formater I’axe dans le menu contex-
tuel.

— Sélectionnez I'axe désiré dans la liste déroulante de la barre d’outils Formatage puis cli-
guez sur I'icone Formater la sélection a sa droite.
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— Cliquez sur un des boutons Axe X [ili , Axe Y :li, Axe Z il ou Tous les axes  dans
la barre d'outils Formatage.

3) Cliguez sur I'onglet approprié pour effectuer les changements voulus. Les options de chaque
onglet sont expliquées ci-dessous.

4)  Cliquez sur OK pour refermer la boite de dialogue. Si nécessaire, cliquez hors du dia-
gramme pour quitter le mode d’édition.

Définir I'échelle

Axe Y X

ositionnement Ligne Etiquette Nombres Police Effets de caractére Typographie asiatique

Echelle

[Inverser la direction

[JEchelle logarithmique

Minimum 0 - | M Automatique
Maximum 60 - | M Automatique
Intervalle principal 10 - MAutomatique
Nombre d'intervalles secondaires 2 - MAutomatique

Figure 27 : I'onglet Echelle de la boite de dialogue Axe.

Utilisez I'onglet Echelle pour modifier I'échelle créée automatiquement pour un axe primaire ou
pour définir pour un axe secondaire une échelle différente de celle de I'axe primaire. Cela peut, par
exemple, étre utile pour afficher une échelle en degrés Celsius et une autre en degrés Fahrenheit
sur le méme diagramme, ou quand des données sont alignées sur un axe secondaire Y (voir « Ali-
gner des données sur I’axe Y secondaire », page 23).

Le contenu de I'onglet Echelle varie mais peut contenir les options suivantes :

Inverser la direction
Cette option définit I'ordre des plus petites et des plus grandes valeurs le long des axes.
Quand elle n'est pas cochée, I'axe X affiche les valeurs les plus petites a gauche et 'axe Y
en bas. Quand elle est cochée, 'orientation de 'affichage des valeurs est inversée comme
sur la Figure 28.

Location d'équipements

Mois

Janvier Février Mars Auvril Juin

0 W Canoés
1 M Bateaux
20 Rafts

30
40
50
60

o

Nombre

Figure 28 : Inversion de 'axe Y.
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Echelle logarithmique
Cette option définit une graduation logarithmique de I'axe : on passe d’'une graduation a une
autre en multipliant par un méme nombre (10 par défaut), au lieu d’ajouter ce nombre
comme dans une graduation linéaire ordinaire. Cochez cette option si vous travaillez avec
des valeurs qui peuvent étre tres éloignées les unes des autres, mais indiquez-le dans le
titre de I'axe, car ce n’est pas ce que la plupart des gens attendent.

Minimum et Maximum
Ces champs définissent la valeur la plus basse et la plus haute de I'axe. L'option Automa-
tique doit étre décochée pour pouvoir les modifier.

Intervalle principal
Ce champ définit I'intervalle entre les graduations principales de I'axe qui sera utilisé pour
tracer les marques (spécifiees dans I'onglet Positionnement) et les lignes de la grille. L'option
Automatique doit étre décochée pour pouvoir modifier cette valeur.

Nombre d’intervalles secondaires
Ce champ définit le nombre de subdivisions de l'intervalle principal (non la valeur qui les sé-
pare). Ce nombre sera utilisé pour tracer les marques secondaires (spécifiées dans 'onglet
Positionnement) et les lignes secondaires de la grille. L’'option Automatique doit étre déco-
chée pour pouvoir modifier cette valeur.

Pour certains types de diagrammes, des options supplémentaires peuvent étre disponibles :

Type
Cette option spécifie si les étiquettes sont des textes, des dates ou doivent étre détectées
automatiquement.

Résolution
Pour les dates, cette option précise si l'intervalle de graduation est en jour, en mois ou en an-
nées.

N\, 7

/Q\ Conseil
Si 'axe X n'affiche pas les valeurs de dates comme prévu, saisir manuellement les dates mi-
nimum et maximum sur cette page peut résoudre le probleme.

Positionner les axes, les étiquettes et les marques d’intervalles

Echelle

ent Ligne Etiquette Nombres Police Effets de caractére Typographie asiatique
Ligne de I'axe

Croiser |'autre axe & Catégorie = ‘ Janvier|
Etiquettes

Placer les étiquettes Prés de l'axe VI
Marques d'intervalle

Principal : [JIntérieur [V]Extérieur

Secondaire : [lIntérieur []Extérieur

Placer les marques |A I'axe et aux étiquettes ‘

Figure 29 : I'onglet Positionnement de la boite de dialogue Axe.
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L'onglet Positionnement (Figure 29) contrdle la position des axes, étiquettes et marques d'inter-
valles.

Ligne de I'axe
Cette section définit I'endroit ou I'axe croise I'autre axe, comme sur la Figure 30. Les options
de la liste déroulante sont Début, Fin et une valeur ou une catégorie spécifiée.

120.
B 100 = u
| 80
60
40
20

0
20 30 40 50 60

Figure 30 : I'axe Y coupe 'axe X a une valeur définie.

Etiquettes
Choisissez dans la liste déroulante la position des étiquettes de I'axe. Les options Début a
I'extérieur et Fin a l'extérieur sont utiles pour positionner les étiquettes sur des axes avec des
valeurs négatives comme sur la Figure 31.

Prées de l'axe Pres de I'axe (autre coté)

1,5 1,5

1 1

0.5 050 10 20 30 40 50 60 70 80 90 100
0 0
050 10 20 30 40 50 60 70 80 90 100 .

-1 -1

Début a l'extérieur Fin a l'extérieur

1,5 0 10 20 30 40 50 60 70 80 90 100
1 1,5

0,5 1

0 0,5
-0,5 0

1 0,5

0 10 20 30 40 50 60 70 80 90 100 -1
Figure 31 : Positions des étiquettes d’axe.

Marques d’intervalle
— Principal / Secondaire : ces options précisent si les marques sont tracées pour les gra-
duations principales ou secondaires. Celles-ci dont définies dans I'onglet Echelle décrit ci-
dessus.

— Intérieur / Extérieur : ce choix indique si les marques sont tracées du c6té interne ou ex-
terne de I'axe. Sur la Figure 31, elles sont tracées des deux c6tés.
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— Placer les marques : I'option choisie ici spécifie ou tracer les marques : aux étiquettes, a
I'axe ou a 'axe et aux étiquettes. (Sur la Figure 31, les deux exemples du haut montrent
les étiquettes le long de I'axe : les marques sont donc tracées a I'axe et aux étiquettes.
Sur les deux exemples du bas, elles sont tracées aux étiquettes.)
L’onglet Ligne

L'onglet Ligne offre des options pour formater le style de ligne de I'axe, sa couleur, sa largeur et sa
transparence. Son contenu est le méme que celui de I'onglet Ligne de la boite de dialogue Séries
de données visible sur la Figure 22, page 26.

L’onglet Etiquette

Dans 'onglet Etiquette (Figure 32) vous permet de choisir d’afficher ou non les étiquettes et de
préciser comment le faire si elles ne s’accordent pas correctement au diagramme.

Echelle Positionnement Ligne

e Nombres Police Effets de caractére Typographie asiatique
V] Afficher les étiquettes

Ordre Enchainements
OcCarreler []Chevaucher
O Echelonnement impair [ ]Sauter

O Echelonnement pair
(® Automatique
Orientation du texte

-, LIEmpilé verticalement

0 = Degrés

B ABCD *

%

Direction du texte : Utiliser les paramétres de |'objet supérieur |~ |

Figure 32 : l'onglet Etiquette de la boite de dialogue Axe.

Afficher les étiquettes
Cette option définit si les étiquettes de I'axe sont affichées ou non.

Ordre
Ces options précisent I'alignement horizontal ou vertical des étiquettes sur les axes X et Y.
Ces options ne sont accessibles que pour les diagrammes en 2D.

— Carreler : les étiquettes sont disposées cOte a cbte sur l'axe,

— Echelonnement impair : décale les étiquettes de rang pair vers le bas (étiquettes sous
I'axe ou de diagramme) ou vers le haut (étiquettes au-dessus de I'axe ou du diagramme)
pour un axe horizontal et vers la gauche ou la droite pour un axe vertical.

— Echelonnement pair : fait la méme chose avec les étiquettes de rang impair.

— Automatique : dispose automatiquement les étiquettes par rapport a I'axe.
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= Remarque

Des problémes peuvent se produire si le diagramme est trop petit. Pour les résoudre, agran-
dissez le diagramme ou diminuez la taille de la police.

Enchainement
Ces options définissent comment le texte des étiquettes est disposé (en cas de manque de
place).

— Chevaucher : les textes des étiquettes peuvent se chevaucher.
— Sauter : une étiquette sur deux est affichée et elles sont inclinées pour limiter leur largeur.
— Chevaucher et sauter : les étiquettes sont écrites sur plusieurs lignes.

Orientation du texte
Ces champs déterminent la direction et I'orientation des étiquettes.

— Empilé verticalement : cochez cette option pour écrire les étiquettes verticalement, mais
avec des lettres qui conservent leur orientation habituelle, pour pouvoir les lire de haut en
bas.

— Roue ABCD : cliquez et tirez la petite marque a la périphérie de la roue pour définir
I'orientation du texte. Le texte ABCD au centre de la roue suit le réglage.

— Degrés : ce champ interagit avec la roue pour déterminer I'orientation du texte. Si vous
utilisez la roue, le champ indique I'angle en degrés. Si vous modifiez le champ, la roue et
son texte central tournent pour refléter I'orientation choisie.

— Direction du texte : Le choix dans cette liste spécifie la direction de tout texte qui utilise la
Mise en page de texte complexe qui n’est disponible que si cette option est cochée dans
la page Paramétres linguistiques — Langues de la boite de dialogue Options (Outils > Op-
tions > Parameétres linguistiques > Langues dans la barre de menu). Dans la section
Prise en charge linguistique avancée, cochez I'option Ignorer la langue d’entrée du
systéme.

L’onglet Nombres

Utilisez I'onglet Nombres (Figure 33) pour paramétrer les nombres utilisés sur les axes. Quand
I'option Format de la source est cochée (ce qui est le cas par défaut), les nombres sont formatés
exactement comme dans le classeur. Décochez-la pour modifier leur mise en forme. Pour plus
d’informations sur le formatage des nombres, veuillez vous reporter au chapitre 2, Saisir, éditer et
formater les données, de ce guide ainsi qu'a l'aide.

Police et effets de caractere

Utilisez ces deux onglets pour définir la police et les effets appliqués aux étiquettes des axes. lls
sont identiques a ceux qui définissent la police et les effets appliqués au contenu des cellules.
Veuillez vous reporter au chapitre 2, Saisir, éditer et formater les données, de ce guide pour plus
d’informations.
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Echelle Positionnement Ligne Etiquette Nombres Police Effets de caractére

Catégorie Format Langue

2 Par défaut - Frangais (France) |
Pourceﬁtage -1235 [IFormat de la source
Monnaie -1234,57

Date -1235

Heure -1 234,57

Scientifique -1234,57

Fraction

Valeur logique -1234,56789012346
Texte v

Options

Nombre de décimales : LINombres négatifs en rouge

4 F 4

Zéros non significatifs : 1 [ISéparateur de milliers
Description de format
Standard

Défini par |'utilisateur

Figure 33 : I'onglet Nombres de la boite de dialogue Axe.
Typographie asiatique

Cet onglet permet de définir les options pour la typographie asiatique utilisée pour les étiquettes
des axes. Il n"apparait que si un support de langue étendu est activé dans la page Parametres lin-
guistiques — Langues de la boite de dialogue Options (Outils > Options > Paramétres linguis-
tiques > Langues dans la barre de menu). Dans la section Prise en charge linguistique avan-
cée, cochez I'option Ignorer la langue d’entrée du systéme.

Les options disponibles sont :

Appliquer la liste des caractéres interdits en début et en fin de liste
Cette option évite que les caracteres de la liste commencent ou terminent une ligne. lls sont
replacés soit dans la ligne précédente, soit dans la suivante. Pour éditer la liste de ces ca-

racteres, ouvrez la page Parametres linguistiques — Langues de la boite de dialogue Op-
tions.

Autoriser la ponctuation en retrait

Cette option évite que les virgules et points coupent une ligne. A la place, ces caractéres
sont ajoutés en fin de ligne, méme dans la marge.

Applique I'espacement entre du texte asiatique et non asiatique
Cette option insére un espace entre les caractéres asiatiques, latins et complexes.

Etiquettes d’axe hiérarchisées

Plusieurs niveaux de catégories peuvent étre affichés de facon hiérarchisée le long de I'axe d’'un
diagramme. lls sont automatiquement créés si la premiére colonne ou ligne définie comme don-
nées est du texte (par opposition a la premiére colonne ou ligne définie comme étiquettes). La Fi-
gure 34 en montre un exemple. Dans ce cas, Calc définit automatiquement la plage de données
des catégories comme étant constituée de deux premiéres colonnes du classeur. Cela se reflete
dans le diagramme qui affiche une relation hiérarchique entre les trimestres et les mois.
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Locations

Canoés Bateaux Rafts
1* trimestre Janvier 12 23 47
Février 9 31 54
Mars 14 27 56
2°trimestre Awril 17 28 48
Mai 13 19 39
Juin 8 27 52
60
50
40
30 B Canoés
W Bateaux
20 Rafts
0
Janvier Février Mars Avril Mai Juin
ler trimestre 2e trimestre

Figure 34 : Exemple d’étiquettes hiérarchisées sur I'axe X.

Etiquettes de données

Les étiquettes de données affichent des informations a c6té des points de données dans le dia-
gramme. Elles peuvent se révéler pratiques pour mettre en évidence des données particuliéres en
présentant une information détaillée, a condition de prendre soin de ne pas créer un diagramme
trop surchargé pour étre lu facilement.

Ajouter des étiquettes a une série de données et les formater

Pour ajouter ou formater des étiquettes a une série de données

1) Sélectionnez le diagramme par un double clic sur celui-ci pour entrer en mode d’édition. Il
doit étre entouré d’'une bordure épaisse grise.

2) Effectuez une des actions suivantes pour sélectionner une série de données particuliére :
— Cliquez une fois quelque part dans la série de données.

— Sélectionnez le nom de la série de données dans la liste déroulante de la barre d'outils
Formatage.

=/ Remarque

Si aucune série de données n'est sélectionnée, elles recevront toutes des étiquettes.

3) Ouvrez la boite de dialogue Etiquettes de données (Figure 35), en effectuant 'une des ac-
tions suivantes :

— Sélectionnez Insertion > Etiquettes de données dans la barre de menu.

— Faites un clic droit sur la série de données et sélectionnez Insérer des étiquettes de
données dans le menu contextuel. Calc affiche des étiquettes de données avec des pa-
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rametres par défaut. Faites un nouveau clic droit et choisissez Formater les étiquettes
de données dans le menu contextuel.

4)  Sélectionnez les options souhaitées. Elles sont expliquées ci-dessous.

5) Cliquez sur OK pour refermer la boite de dialogue. Si nécessaire, cliguez hors du dia-
gramme pour quitter le mode d’édition.

Etiquettes de données pour les séries de données 'Bateaux’

Bordures Ftiquettes de données Police Effets de caractére Typographie asiatique

Attributs de texte

I Afficher les valeurs comme nombre| Format de nombre...
U] Afficher la valeur sous forme de pourcentage ~ Format de pourcentage. .
| Afficher la catégorie

Ll Afficher le symbole de légende

[IRenvoi a la ligne automatique

Séparateur |Espace ]

Placement Au-dessus X

Pivoter le texte

“

i ABCD = 0 ~ Degrés

-4 ~

Direction du texte Utiliser les paramétres de I'objet supérieur ~

Figure 35 : l'onglet Etiquettes de données de la boite de dialogue de méme nom.

N\, -
/Q\ Conseil
En cliquant une fois sur une colonne, une barre ou autre représentation graphigue, vous se-

lectionnez la série de données. En cliquant de nouveau, aprés une pause pour ne pas faire
un double clic, vous sélectionnez un point de données unique dans la série.

La plupart des onglets de la boite de dialogue Etiquettes de données se rencontrent dans les
autres boites de dialogue et peuvent se comprendre facilement. La seule exception est I'onglet Eti-
quettes de données (Figure 35) qui comporte les options suivantes :

Attributs de texte
— Afficher les valeurs comme nombre : si cette option est cochée, la valeur numérique d’'un
point de données est affichée. Une fois cochée, cette option active le bouton Format de
nombre

— Format de nombre : ce bouton ouvre la boite de dialogue Formater le nombre qui est
identique a I'onglet Nombre de la boite de dialogue Formatage des cellules décrite au
chapitre 2, Saisir, éditer et formater les données. Elle posséde en plus une option Format
de la source qui est cochée par défaut et qui applique le formatage que les données pos-
seédent dans le classeur. Décochez-la pour activer les autres options de la boite de dia-
logue.
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— Afficher la valeur sous forme de pourcentage : cochez cette option pour afficher la valeur
des points de la série de données en pourcentage de la somme des valeurs de toutes les
séries de données qui correspondent & la méme catégorie ou valeur X.

— Par exemple, dans la Figure 36, la série Canoés pour le mois de février a une valeur
égale a 9 qui représente 10 % de 94 (=9 + 31 + 54).

60
Février Mars
54 56 Juin
50 Janvier Avril 52
47 48
40 Mai
39
=—4— Février, 31 )
30 —o— Mars, 27 —*— Avril, 28 == Canoés
——Janvi : =—— Bateaux
anvie 2 mafts
20 27
Auvril; 17; 18 %
ars; 14; 14 % iana.
Janviet: 12; 15 % 0 Mai; 13; 189
Février; 9; 10 % Juin: 8: 9 %

0
Janvier Février Mars Auvril Mai Juin

Figure 36 : Exemples d’'étiquettes de données avec diverses options.

— Format de pourcentage : ce bouton ouvre la méme boite de dialogue que le bouton For-
mat de nombre. Comme dans ce cas, décochez I'option Format de la source pour accé-
der aux paramétres qu’elle contient.

— Afficher la catégorie : cochée, cette option affiche la catégorie pres des points de don-
nées. Elle est active pour toutes les étiquettes dans la Figure 36 qui affichent donc toutes
le mois. Le texte utilisé provient des séries de données catégories et on ne peut pas le
modifier dans le diagramme, mais seulement dans les données du classeur.

— Afficher le symbole de la légende : cochez cette option pour afficher I'icbne de la [égende
prés des points de données. Dans la Figure 36, elle est active pour les séries Bateaux et
Rafts mais pas pour la série Canoés.

— Renvoi a la ligne automatique : cochez pour que Calc effectue un renvoi a la ligne si né-
cessaire.

— Séparateur : sélectionnez le séparateur utilisé quand deux des options précédentes au
moins sont cochées. Dans la Figure 36, le séparateur est un point-virgule pour la série
Canoés, une virgule pour la série Bateaux (sauf Juin modifié pour ne pas recouvrir la lé-
gende) et un saut de ligne pour la série Rafts.

— Placement : spécifiez ici la position des étiquettes de données par rapport a la représenta-
tion du point de données. Dans la Figure 36, la position est En dessous pour la série Ca-
noés, Au-dessus pour la série Bateaux (sauf Juin, En dessous) et Droite pour la série
Rafts.

Pivoter le texte
Définissez I'orientation des étiquettes de données en utilisant la roue ou le champ Degrés
(voir page 35).
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— Direction du texte : vous pouvez préciser ici la direction du texte quand la Mise en page
de texte complexe est activée, ce qui est nécessaire quand la forme et la position des ca-
ractéres dépendent du contexte, comme c’est le cas en écriture arabe.

Etiquettes pour des points de données individuels

Il vaut parfois mieux afficher des étiquettes a quelques points de données plutét qu’a tous. Cela
aére le diagramme et souligne les données les plus importantes.

Ajouter une étiquette de donnée unique
Pour insérer une étiquette pour un point de donnée unique, procédez de la maniére suivante :

1) Sélectionnez le diagramme par un double clic sur celui-ci pour entrer en mode d’édition. Il
doit étre entouré d’'une bordure épaisse grise.

2) Cliguez une fois sur le point de données, faites une pause pour éviter le double-clic puis cli-
guez de nouveau (cliquer trop vite peut provoquer un double-clic, qui ouvre la boite de dia-
logue Séries de données).

3) Faites un clic droit sur le point de donnée et sélectionnez Insérer une seule étiquette de
donnée dans le menu contextuel. L'étiquette apparait avec les paramétres par défaut.

4)  Cliquez sur OK pour refermer la boite de dialogue. Si nécessaire, cliquez hors du dia-
gramme pour quitter le mode d’édition.

Formater une étiquette de donnée unique

Pour formater I'étiquette existante d’'un point de donnée unique, suivez les instructions précé-
dentes jusqu’au point 3 et faites un clic droit sur le point de données et sélectionnez Formater une
seule étiquette de donnée dans le menu contextuel.

Les options de la boite de dialogue Etiquette de donnée sont décrites ci-dessus.

Vous pouvez aussi accéder a la boite de dialogue en cliquant sur I'étiquette de donnée une pre-
miere fois, puis une deuxieme fois apres une pause, et en faisant un clic droit avant de sélection-
ner Formater une seule étiquette de donnée dans le menu contextuel.

Supprimer les étiquettes de données

Utilisez une des méthodes suivantes pour supprimer les étiquettes d'un point de donnée unique,
d’une unique série de données ou de tous les points de données.

Dans tous les cas, commencez par sélectionner le diagramme par un double clic sur celui-ci pour
entrer en mode d’édition. Il doit étre entouré d’'une bordure épaisse grise. Quand vous avez termi-
né, cliguez sur OK pour refermer la boite de dialogue. Puis, si nécessaire, cliquez hors du dia-
gramme pour quitter le mode d’édition.

Supprimer toutes les étiquettes d’une série de données unique

Premiére méthode
Faites un clic droit dans la série de données et sélectionnez Supprimer les étiquettes de
données dans le menu contextuel.

Deuxiéme méthode
1) Cliguez dans la série de données pour la sélectionner.
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2) Effectuez une des actions suivantes pour ouvrir la boite de dialogue Etiquettes de données
(Figure 35) :

— Sélectionnez Insertion > Etiquettes de données dans la barre de menu.

— Faites un clic droit sur la série de données et sélectionnez Formater les étiquettes de
données dans le menu contextuel.

— Cliguez sur I'icdne Formater la sélection dans la barre d’outils Formatage.

3) Décochez toutes les options de I'onglet Etiquettes de données.

Supprimer I’étiquette d’un point de donnée unique

1) Cliquez une fois sur le point de données, faites une pause pour éviter le double-clic puis cli-
guez de nouveau (cliquer trop vite, double clic, ouvre la boite de dialogue Séries de don-
nées).

2) Faites un clic droit sur le point de donnée et sélectionnez Supprimer une seule étiquette
de donnée dans le menu contextuel.

Supprimer toutes les étiquettes de données
1) Vérifiez qu’aucune étiquette ou série de données n’est sélectionnée.
2) Choisissez Insertion > Etiquettes de données dans la barre de menu.

3) Décochez toutes les options de l'onglet Etiquettes de données.

Les grilles

Les grilles principales et secondaires partagent les graduations des axes pour faciliter I'estimation
des valeurs des points de données. Un exemple est proposé sur la Figure 37.

100

0
0 1 2 3 4 5 6 7

Figure 37 : Grilles principale et secondaire pour les axes X et Y

Les lignes les plus foncées, commencant au niveau des nombres, forment la grille principale, tan-
dis que les plus claires entre elles forment la grille secondaire. Notez que la grille principale de
'axe Y est visible par défaut.

Les grilles sont disponibles pour tous les types de diagrammes sauf les secteurs.

Ajouter ou supprimer des grilles

1) Sélectionnez le diagramme par un double clic sur celui-ci pour entrer en mode d’édition. Il
doit étre entouré d’'une bordure épaisse grise.

2) Effectuez une des actions suivantes :

— Sélectionnez Insertion > Grilles dans la barre de menu pour ouvrir la boite de dialogue
Grille de base. Cochez ou décochez les options souhaitées. L'option Axe Z n'est active
gue pour les diagrammes en 3D.
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Grilles X

Grilles principales Grilles secondaires
[ Axe X

Aide Annuler

Figure 38 : la boite de dialogue Grilles de base.

— Cliquez sur un des boutons ki (pour les grilles de I'axe Y) ou |l (pour les grilles de I'axe
X) dans la barre d’outils Formatage. Un premier clic active la grille principale, un
deuxiéme active la grille secondaire et un troisieme les désactive.

3) Cliguez sur OK pour refermer la boite de dialogue. Si nécessaire, cliguez hors du dia-
gramme pour quitter le mode d’édition.

= Remarque

Dans la barre d'outils Formatage, les icones Grilles horizontales :l: et Grilles verticales
lIi gérent les grilles associées respectivement & I'axe Y et & I'axe X. Cela peut étre trom-
peur, car les deux axes peuvent étre soit horizontaux, soit verticaux selon le type de dia-

gramme. Ainsi, avec un diagramme en barres, il faut cliquer sur I'icéne Grilles horizontales
pour contréler la grille verticale.

Formater les grilles

En plus de la boite de dialogue de base visible sur la Figure 38, une autre permet de formater les
grilles. Pour ouvrir la boite de dialogue de formatage des grilles (Figure 39) :

Axe X de la grille principale

Ligne

Propriétés de ligne
Style :
—Continu
Couleur :
| #B3B3B3 b
Largeur:
000cm =
Transparence :
0% -

Aide Réinitialiser Annuler

Figure 39 : la boite de dialogue de formatage des grilles.
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1)

2)

3)
4)

~7
e

Sélectionnez le diagramme par un double clic sur celui-ci pour entrer en mode d’édition. I
doit étre entouré d’'une bordure épaisse grise.

Sélectionnez Format > Grilles dans la barre de menu et choisissez le type de grille qui vous
convient.

Définissez les options pour le style, la couleur, la largeur et la transparence des lignes.

Cliquez sur OK pour refermer la boite de dialogue. Si nécessaire, cliquez hors du dia-
gramme pour quitter le mode d’édition.

Remarque

Utilisez I'onglet Echelle de la boite de dialogue Axe pour définir I'intervalle entre les lignes
de la grille, comme décrit dans « Définir I’échelle », page 31.

Diagrammes en 3D

Créer I’aspect 3D

Les diagrammes en colonnes, en barres, en secteurs et en zones peuvent étre affichés en 3D.
L'option pour obtenir un diagramme en 3D se trouve sur la premiére page de l'assistant de dia-
grammes. S'il a déja été créé, vous pouvez lui donner un aspect en 3D de la fagon suivante :

1)

2)

3)
4)

Sélectionnez le diagramme par un double clic sur celui-ci pour entrer en mode d’édition. Il
doit étre entouré d’'une bordure épaisse grise.

Effectuez une des actions suivantes :
— sélectionnez Format > Type de diagramme dans la barre de menu,
— cliquez sur le bouton Type de diagramme | 2 dans la barre d’outils Formatage,

— faites un clic droit dans le diagramme et sélectionnez Type de diagramme dans le menu
contextuel.

Cochez 'option 3D dans la boite de dialogue Type de diagramme.

Cliquez sur OK pour refermer la boite de dialogue. Si nécessaire, cliquez hors du dia-
gramme pour quitter le mode d’édition.

Formater I'affichage 3D

Pour modifier un diagramme en 3D, utilisez la boite de dialogue Affichage 3D (Figure 40) qui per-
met d’en modifier la perspective, 'apparence et I'éclairage. Notez que le diagramme doit déja étre
en 3D comme décrit ci-dessus. Pour ouvrir la boite de dialogue Affichage 3D :

1)

2)

Sélectionnez le diagramme par un double clic sur celui-ci pour entrer en mode d’édition. ||
doit étre entouré d’'une bordure épaisse grise.

Effectuez une des actions suivantes :
— faites un clic droit sur le diagramme et choisissez Affichage 3D dans le menu contextuel,
— sélectionnez Format > Affichage 3D dans la barre de menu,

— cliquez sur le bouton Affichage 3D [ dans la barre d'outils Formatage.

Diagrammes en 3D | 43



3)

4)

Effectuez les réglages souhaités dans la boite de dialogue Type de diagramme qui possede
trois onglets présentés ci-dessous.

Cliquez sur OK pour refermer la boite de dialogue. Si nécessaire, cliquez hors du dia-
gramme pour quitter le mode d’édition.

Rotation et perspective

Affichage 3D

Perspective Apparence Eclairage
|¢|£xesaang Iedr0| t

Rotation X 11°
Rotation Y 25°

Rotation Z

4k A r A 4»

[IPerspective 20 %

Figure 40 : L'onglet Perspective de la boite de dialogue Affichage 3D

Quelques conseils pour faire pivoter un diagramme en 3D grace a I'onglet Perspective et changer
sa perspective :

Mettez les angles a O pour une vue de face. Les diagrammes en secteurs et en tores appa-
raissent circulaires.

Si Axes a angle droit est cochée, le diagramme ne peut pivoter que dans les directions X et
Y, parallelement aux bords.

Si Rotation X vaut 90° et Rotation Y et Rotation Z 0°, on a une vue du dessus du diagramme.
Si Rotation X vaut —=90°, on a une vue du dessous.

Les rotations sont appliquées dans I'ordre suivant : d’abord I'axe X, puis I'axe Y et enfin I'axe
Z.

Quand I'ombrage est actif et que le diagramme est pivoté, la source de lumiére tourne
comme si elle était liée au diagramme.

Les axes de rotation font toujours référence a la page, pas aux axes du diagramme, ce qui
est différent d’autres programmes qui créent des diagrammes.

Cochez l'option Perspective pour voir le diagramme en perspective centrale comme a travers
un objectif (par opposition a une projection paralléle). Définissez la longueur focale avec le
champ voisin en tapant une valeur ou en vous aidant des fleches. Réglée a 100 %, le bord le
plus éloigné du diagramme apparait environ deux fois plus petit que le premier plan.

Faire pivoter le diagramme de facon interactive

En plus de I'onglet Perspective de la boite de dialogue Affichage 3D, vous pouvez faire pivoter un
diagramme 3D de fagon interactive de la maniére suivante :

1)

2)

Sélectionnez le diagramme par un double clic sur celui-ci pour entrer en mode d’édition. Il
doit étre entouré d’'une bordure épaisse grise.

Cliquez une fois sur la paroi du diagramme pour la sélectionner et faire apparaitre des poi-
gnées de sélection rondes. Le curseur prend la forme d’une icbne de rotation.
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3) Maintenez le bouton gauche enfoncé en tirant dans la direction désirée. Un contour en poin-
tillé du diagramme apparait pour vous aider a visualiser le résultat.

4) Relachez le bouton quand le résultat souhaité est obtenu.
5) Cliguez hors du diagramme pour quitter le mode d’'édition.

L’onglet Apparence

Utilisez I'onglet Apparence de la boite de dialogue Affichage 3D (Figure 41) pour modifier certains
aspects de I'apparence des points de données dans un diagramme en 3D.

Affichage 3D X

Perspective Apparence Eclairage

Jeu ZE

[vIOmbrage
[IBordures d'objet

[v|Arrondis d'arétes

Figure 41 : I'onglet Apparence de la boite de dialogue Affichage 3D.

Commencez par sélectionner un jeu dans la liste déroulante : Réaliste (par défaut) ou Simple. Le
jeu choisi définit les options et les sources de lumiére. Selon le jeu choisi, toutes les options ne

sont pas disponibles. Pour créer un jeu personnalisé, cochez ou décochez une combinaison des
options Ombrage, Bordures d’objet et Arrondis d'arétes.

Quelques indications :

*  Cochez Ombrage pour utiliser la méthode de Gouraud pour le rendu de surface. Si elle n'est
pas cochée, une méthode simple, qui attribue une couleur et une luminosité unique a chaque
polygone est utilisée. Les arétes sont visibles mais les dégradés progressifs et éclairages
ponctuels ne sont pas possibles. La méthode de Gouraud applique des dégradés pour un
aspect plus lisse et plus réaliste. Veuillez vous reporter au Guide Draw pour plus d'informa-
tion sur l'utilisation des ombrages.

»  Cochez Bordures d’objet pour gu’une ligne soit tracée le long des arétes.
«  Cochez Arrondis d’arétes pour lisser les arétes des formes parallélépipédigues.
L’onglet Eclairage

Utilisez l'onglet Eclairage (Figure 42) de la boite de dialogue Affichage 3D pour contréler les
sources de lumiére qui éclaire le diagramme.

Voici les options avec quelques conseils :
*  Cliquez sur les huit boutons pour allumer ou éteindre une source de lumiére directive.
*  La premiére source projette une lumiére spéculaire réfléchie par la surface des objets.

* La deuxiéme source est allumée par défaut. C’est la premiére des sept sources de lumiére
étendues normales.
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*  Choisissez une couleur pour la source sélectionnée dans la palette déroulante située sous
les huit boutons. Notez que les luminosités des sources s'ajoutent les unes aux autres : utili-
sez des couleurs foncées si vous allumez plusieurs sources.

*  Au départ, les sources sont toutes dirigées vers le centre de I'objet. Utilisez le curseur verti-
cal pour modifier 'angle et le curseur horizontal pour tourner autour de I'objet. Vous pouvez
aussi cliquer sur la source et la tirer & la position souhaitée.

*  L'apercu montre I'effet obtenu en déplacant les sources de lumiére.

*  Chaque source apparait sous forme d’'une petite sphére colorée avec la couleur choisie. La
plus grosse représente la source sélectionnée.

*  Cliquez sur le bouton en bas a droite de I'apercu (a l'intersection des ascenseurs) pour rem-
placer la sphére par un cube et inversement.

«  Utilisez la liste déroulante Luminosité ambiante pour définir la lumiére ambiante qui brille
avec une intensité uniforme dans toutes les directions.

Affichage 3D X

Perspective Apparence Eclairage

Source de lumiére

: ~| (e
] Indigo A . m
Luminosite ambiante

B Gris foncé 1 v || e

Figure 42 : 'onglet Eclairage de la boite de dialogue Affichage 3D.

Veuillez vous reporter au Guide Draw pour plus d’information sur le réglage de I'éclairage d’'une
scéne en 3D.

Courbes de tendance et de valeurs moyennes

Les courbes de tendance aident a montrer les relations entre les points dispersés d’une série de
données. Calc offre un bon choix de types de régression pour la création de courbes de tendance :
linéaire, logarithmique, exponentiel, puissance, polynomiale et moyenne glissante. Choisissez le
type qui produit une courbe qui passe le plus prés de tous les points de la série.

Des courbes de tendance peuvent étre ajoutées a tous les types de diagrammes en 2D, sauf les
diagrammes en secteurs, en toile et représentant des cours. Une fois insérées dans le diagramme,
leurs représentations sont automatiquement ajoutées a la Iégende.
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Remarque

Pour les types de diagrammes qui utilisent des catégories pour I'axe X, comme les dia-
grammes en colonnes, en barres ou en lignes, les nombres 1, 2, 3... sont utilisées comme
valeurs pour calculer la courbe de tendance. En revanche, les types de diagrammes XY
(dispersion), ainsi que les diagrammes en bulles, utilisent des données au lieu de catégories
le long de I'axe X. En conséquence, ce sont les seuls types de diagrammes pour lesquels
I'équation de la courbe de tendance ait un sens.

Ajouter et modifier des courbes de tendance

Les courbes de tendance ne peuvent étre ajoutées qu’a une série de données a la fois. Pour cela :

1)

2)

3)

4)
5)

Sélectionnez le diagramme par un double clic sur celui-ci pour entrer en mode d’édition. Il
doit étre entouré d’'une bordure épaisse grise.

Effectuez une des actions suivantes pour sélectionner une série de données particuliére :

— Cliguez une fois sur un représentant de la série de données, barre, colonne, ligne ou
point.

— Sélectionnez le nom de la série de données dans la liste déroulante de la barre d’outils
Formatage.

Ouvrez la boite de dialogue Courbe de tendance, en effectuant 'une des actions suivantes :
— Sélectionnez Insertion > Courbe de tendance dans la barre de menu.

— Faites un clic droit sur la série de données et sélectionnez Insérer une courbe de ten-
dance dans le menu contextuel.

Sélectionnez le type de régression et les options souhaités. lls sont expliqués ci-dessous.

Cliquez sur OK pour refermer la boite de dialogue. Si nécessaire, cliquez hors du dia-
gramme pour quitter le mode d’édition.

Types de régressions

Par défaut, x est utilisé pour la variable en abscisse et f(x) pour la variable en ordonnées. Vous
pouvez changer ces noms dans les champs Nom de la variable X et Nom de la variable Y en bas
de la boite de dialogue.

Régression linéaire

L'équation de la courbe est du type y = a - x + b. La valeur de b peut étre imposée en co-
chant l'option Forcer I'ordonnée a l'origine et en paramétrant celle-ci dans le champ voisin.

Régression polynomiale

L’équation de la courbe est du type y = 2(a; - X). La valeur de a, peut étre imposée en co-
chant I'option Forcer I'ordonnée a l'origine et en paramétrant celle-ci dans le champ voisin.
Le degré du polyndme doit étre défini dans le champ Degré (2 au minimum).

Régression logarithmique

L'équation de la courbe est du type y = a - In(x) + b. Seules les valeurs positives de x sont
prises en compte.
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Régression exponentielle
L'équation de la courbe est du type y = b - exp(a - x) ou, de maniére équivalente, y = b - m"*,
avec m = exp(a). La valeur de b peut étre imposée en cochant I'option Forcer I'ordonnée a
I'origine et en paramétrant celle-ci dans le champ voisin. Seules les valeurs positives de y
sont prises en compte, sauf si elles sont toutes négatives, cas dans lequel I'équation utilisée
esty=-b - exp(a - x).

Régression en loi de puissance
L'équation de la courbe est du type y = b - x°. Seules les valeurs positives de y sont prises en
compte, sauf si elles sont toutes négatives, cas dans lequel I'équation utilisée est y = —b - x°.

Moyenne glissante
Effectue une simple moyenne glissante des n valeurs de y précédentes, ou n est défini dans
le champ Période. Aucune équation n’est disponible pour cette courbe de tendance.

Courbe de tendance pour les séries de données 'Essai 3'

Type Ligne
Type de régression

t.. O Polynomiale

"1 O Logarithmique Degré 2 -
.| OExponentiel |/ .| OMoyenne glissante
. | OPuissance Période 2 -
Options
Nom de la courbe de tendance
Extrapoler en avant 0 -
Extrapoler en arriere 0 -
[IForcer I'ordonnée a l'origine 0 .

[ Afficher I'équation
[ Afficher le coefficient de détermination (R?)
Nom de la variable X

Nom de la variable Y

Figure 43 : I'onglet Type de la boite de dialogue Courbe de tendance.

Options de la courbe de tendance

Nom de la courbe de tendance
Précisez ici le nom utilisé pour la courbe de tendance dans la Iégende ; voir Figure 44

Extrapoler en avant | en arriére
Ce champ définit le nombre d’unités dont la courbe de tendance doit étre prolongée avant le
premier point de donnée ou au-dela du dernier. Cela ne s’applique qu’au diagramme dont
I'axe X utilise des valeurs numériques et non des catégories.

Forcer I'ordonnée a I'origine
Si cette option est cochée, 'ordonnée de l'intersection de la courbe avec I'axe Y est imposée
par la valeur du champ a sa droite.
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Afficher I’équation
Cochez cette option pour afficher I'équation de la courbe comme sur la Figure 44.

Afficher le coefficient de détermination (R?)
Cochez cette option pour afficher le coefficient de détermination sur le diagramme, comme
pour I'équation polynomiale de la Figure 44.

Nom de la variable X | Y
Vous pouvez modifier ici les noms des variables utilisées pour afficher I'équation de la
courbe dans le diagramme. L'option Afficher I'équation doit &tre cochée pour que celles-ci
soient accessibles.

120
|
|
100 = [
| 1) =036x+7269 |
80 [ B Essail
= | inéaire
60 - f(x) = 40,10 In(x) - 73,12 | o Essai?
== | 0garithmique
Essai
0 . ssai 3 .
Polynomiale
20 f(x) = = 0,02 x2 + 2,34 x = 17,44
R2=0,92
0
10 20 30 40 50 60 70

Figure 44 : Exemples de courbes de tendance avec leurs équations.

Si une courbe de tendance est sélectionnée, une information sur celle-ci est visible dans la barre
d’état, normalement située en bas du classeur, comme sur la Figure 45.

M4) )y + | Feuille1

Courbe de tendance f(x) = 0,36 x + 72,69 avec précision R? = 0,1382 sélectionné
Figure 45 : Equation d’une courbe de tendance affichée dans la barre d’état.

Formater les courbes de tendance

Courbe de tendance pour les séries de données 'Essai 3'

Type Ligne
Propriétés de ligne
Style :

e -
E— O tiNU .

Couleur :

L #FFD320 A

Largeur :
010cm '+

Transparence :

-

0 % .

Figure 46 : I'onglet Ligne de la boite de dialogue Courbe de tendance.
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Une fois insérée, la courbe de tendance prend la méme couleur que la série de données corres-
pondante. Pour modifier le style, la couleur, la largeur ou la transparence de la courbe, utilisez I'on-
glet Ligne de la boite de dialogue Courbe de tendance (Figure 46). Les options en sont faciles a
comprendre.

Formater I’équation d’une courbe de tendance

Affichez I'équation dans le diagramme en cochant I'option correspondante dans la boite de dia-
logue Courbe de tendance (Figure 43). Les options proposées pour la mise en forme de I'équation
comportent la bordure qui entoure I'équation, son arriére-plan, sa transparence, sa police et les ef-
fets de caractére. Le style des nombres peut aussi étre précisé, ce qui est assez utile, surtout pour
définir le nombre de chiffres décimaux.

Pour formater I'équation d’'une courbe de tendance :

1) Sélectionnez le diagramme par un double clic sur celui-ci pour entrer en mode d’édition. Il
doit étre entouré d’'une bordure épaisse grise.

2) Ouvrez la boite de dialogue Equation, en effectuant I'une des actions suivantes :

— Sélectionnez I'équation dans la liste déroulante des éléments du diagramme de la barre
d’outils Formatage puis sur I'icbne Formater la sélection dans la barre d'outils For-
matage.

— Cliquez une fois sur I'équation pour la sélectionner puis sur I'icbne Formater la sélection
dans la barre d’outils Formatage.

— Faites un clic droit sur I'équation et sélectionnez Formater I’équation de la courbe de
tendance dans le menu contextuel.

3) Seélectionnez les options souhaitées. Elles sont explicites et faciles a trouver dans l'aide.
L'onglet Nombres propose les mémes options que I'onglet de méme nom de la boite de dia-
logue Axe (Figure 33, page 36).

4)  Cliquez sur OK pour refermer la boite de dialogue. Si nécessaire, cliquez hors du dia-
gramme pour quitter le mode d’édition.

Supprimer les courbes de tendance

1) Sélectionnez le diagramme par un double clic sur celui-ci pour entrer en mode d’édition. Il
doit étre entouré d’'une bordure épaisse grise.

2) Effectuez I'une des actions suivantes :

— Sélectionnez la courbe et appuyez sur la touche Suppr.

— Faites un clic droit sur la courbe et sélectionnez Supprimer la courbe de tendance dans
le menu contextuel.

3) Sinécessaire, cliquez hors du diagramme pour quitter le mode d’édition.

Courbes de valeur moyenne

Les courbes de valeur moyenne sont des courbes de tendance particuliére. Pour les créer, Calc
calcule la moyenne des valeurs d’'une série de données et trace une droite de la méme couleur &
la hauteur de cette moyenne dans le diagramme, comme on le voit sur la Figure 47. Elles ne
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peuvent étre créées que dans des diagrammes en 2D et pas pour les diagrammes en secteurs, en
toile ou qui représentent des cours.

60
50

40 B
N Canoés

=== \JOyenne (Canoés)
30 I Bateaux

Moyenne (Bateaux)
Rafts
I I Moyenne (Rafts)
0

Janvier Février Mars Auvril Juin

2

o

1

o

Figure 47 : Exemples de courbes de valeurs moyennes

Insérer des courbes de valeur moyenne

Pour toutes les séries de données (si aucune série de données n’est sélectionnée, les courbes de
valeur moyenne seront insérées pour toutes les séries) :

1) Sélectionnez le diagramme par un double clic sur celui-ci pour entrer en mode d’édition. Il
doit étre entouré d’'une bordure épaisse grise.

2) Sélectionnez Insertion > Courbes de valeur moyenne dans la barre de menu.
3) Sinécessaire, cliquez hors du diagramme pour quitter le mode d’édition.
Pour une série de données unique :

1) Sélectionnez le diagramme par un double clic sur celui-ci pour entrer en mode d’édition. ||
doit étre entouré d’'une bordure épaisse grise.

2) Effectuez une des actions suivantes pour sélectionner une série de données particuliére :

— Cliquez une fois sur un représentant de la série de données, barre, colonne, ligne ou
point.

— Sélectionnez le nom de la série de données dans la liste déroulante de la barre d’'outils
Formatage.

3) Ajoutez la courbe de valeur moyenne en effectuant 'une des actions suivantes :
— Sélectionnez Insertion > Courbes de valeur moyenne dans la barre de menu.

— Faites un clic droit sur la série de données et sélectionnez Insérer la courbe de valeur
moyenne dans le menu contextuel.

4)  Sinécessaire, cliquez hors du diagramme pour quitter le mode d'édition.
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Modifier les courbes de valeur moyenne

Quand elle est insérée, une courbe de valeur moyenne prend la couleur attribuée a la série de
données. Pour modifier le style, la couleur, la largeur et la transparence de la courbe, faites ceci :

1)

2)

3)
4)

Sélectionnez le diagramme par un double clic sur celui-ci pour entrer en mode d’'édition. Il
doit étre entouré d’'une bordure épaisse grise.

Effectuez une des actions suivantes pour ouvrir la boite de dialogue Courbe de valeur
moyenne, qui propose les mémes options que I'onglet Ligne de la boite de dialogue Courbe
de tendance de la Figure 46 :

— Faites un clic droit sur la courbe et sélectionnez Formater la courbe de valeur moyenne
dans le menu contextuel.

— Sélectionnez la courbe souhaitée dans la liste déroulante des éléments du diagramme de
la barre d’outils Formatage puis sur I'icbne Formater la sélection dans la barre d’ou-
tils Formatage.

Réalisez toutes les modifications que vous désirez.

Cliquez sur OK pour refermer la boite de dialogue. Si nécessaire, cliquez hors du dia-
gramme pour quitter le mode d’édition.

Supprimer les courbes de valeur moyenne

1)

2)

3)

Sélectionnez le diagramme par un double clic sur celui-ci pour entrer en mode d'édition. Il
doit étre entouré d’'une bordure épaisse grise.

Effectuez I'une des actions suivantes :
— Sélectionnez la courbe et appuyez sur la touche Suppr.

— Faites un clic droit sur la série de données et sélectionnez Supprimer la courbe de va-
leur moyenne dans le menu contextuel.

Si nécessaire, cliquez hors du diagramme pour quitter le mode d’édition.

Barres d’erreur

Les barres d’erreur, que montre la Figure 48, peuvent étre utiles pour afficher des données qui pré-
sentent une possibilité d’erreur connue, comme des études sociologiques qui utilisent une mé-
thode particuliere d’échantillonnage ou pour montrer la précision de mesure de I'appareil utilisé.
Elles ne peuvent étre créées que pour des diagrammes en 2D et pas pour les diagrammes en sec-
teurs, en toile ou qui représentent des cours.
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Figure 48 : Exemples de barres d’erreur montrant la variance (Canoés),

I'écart type (Bateaux) et I'erreur standard (Rafts)

Insérer des barres d’erreur

Si aucune série de données n’est sélectionnée, les barres d’erreur X ou Y sont insérées pour
toutes les séries. Pour ajouter des barres d’erreur pour toutes les séries de données :

1)

2)

3)
4)

Barres d'erreur Y pour les séries de données ' Bat... X

Barres d'erreur Y Ligne

Catégorie d'erreur Indicateur d'erreur

O Val tant ® Pociti ot
AEYAEUE CORStAnLE: * (@ Positive et négative
(O Pourcentage .

T * (U Positive

f®) Ecart type v
(O Plage de cellules 1 (ONégative
Parameétres
Positif (+) |0,0 =
Négatif (-) 0,0 =
Valeur identique pour les deux

Aide Réinitialiser Annuler

Figure 49 : la boite de dialogue Barres d’erreur.

Pour insérer une barre d’erreur pour une série de données unique :

Sélectionnez le diagramme par un double clic sur celui-ci pour entrer en mode d’édition. I
doit étre entouré d’'une bordure épaisse grise.

Sélectionnez Insertion > Barres d’erreur X ou Barres d’erreur Y dans la barre de menu
pour ouvrir la boite de dialogue Barres d’erreur (Figure 49).

Choisissez les options désirées. Voir ci-dessous pour plus d’'informations sur ces options.

Cliquez sur OK pour refermer la boite de dialogue. Si nécessaire, cliquez hors du dia-
gramme pour quitter le mode d’édition.
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1) Sélectionnez le diagramme par un double clic sur celui-ci pour entrer en mode d’édition. Il
doit étre entouré d’'une bordure épaisse grise.

2) Effectuez une des actions suivantes pour sélectionner une série de données particuliére :

— Cliguez une fois sur un représentant de la série de données, barre, colonne, ligne ou
point.

— Sélectionnez le nom de la série de données dans la liste déroulante de la barre d’outils
Formatage.

3) Effectuez une des deux actions suivantes pour ouvrir la boite de dialogue Barres d’erreur (Fi-
gure 49) :

— Sélectionnez Insertion > Barres d’erreur X ou Barres d’erreur Y dans la barre de menu.

— Faites un clic droit sur la série de données et sélectionner Insérer des barres d’erreur X
ou Insérer des barres d’erreur Y dans le menu contextuel.

4)  Choisissez les options désirées. Voir ci-dessous pour plus d’informations sur ces options.

5) Cliquez sur OK pour refermer la boite de dialogue. Si nécessaire, cliguez hors du dia-
gramme pour quitter le mode d’édition.

Options de la boite de dialogue Barres d’erreur
Vous pouvez choisir une seule option de la section Catégorie d’erreur :

Valeur constante
Cette option affiche une valeur d’erreur constante, positive ou négative, spécifiée dans la
section Paramétres.

Pourcentage
Cette option affiche une erreur qui représente un pourcentage de la valeur du point de don-
nées. Ce pourcentage est défini dans la section Paramétres.

Liste déroulante
Elle offre quatre choix de représentation : Erreur standard, Ecart type, Variance et Marge
d’erreur définie par la section Parameétres.

Plage de cellules
Cette option utilise les valeurs d’erreurs dans une plage de cellules spécifiée dans la section
Parametres.

Dans la section Paramétres, spécifiez les valeurs ou plages de valeurs positives et négatives pour
les barres d’erreur. Ces options ne sont accessibles que si la catégorie d’'erreur est Valeur
constante, Pourcentage, Marge d’erreur ou Plage de cellules.

Dans la section Indicateur d’erreur, précisez si la barre d’erreur indique seulement les valeurs po-
sitives, négatives ou les deux.
Modifier les barres d’erreur

Les barres d’erreur ne peuvent étre modifiées que pour une série de données a la fois, grace a la
boite de dialogue Barres d’erreur (Figure 49). Ouvrez celle-ci de la maniere suivante :
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1) Sélectionnez le diagramme par un double clic sur celui-ci pour entrer en mode d’édition. Il
doit étre entouré d’'une bordure épaisse grise.

2) Effectuez une des actions suivantes :

— Cliguez une fois sur la série de données pour la sélectionner puis choisissez Insertion >
Barres d’erreur X ou Barres d’erreur Y dans la barre de menu.

— Sélectionnez les barres d’erreur pour la série de données dans la liste déroulante de la
barre d’outils Formatage puis choisissez Format > Formater la sélection dans la barre
de menu ou cliquez sur I'icbne Formater la sélection dans la barre d’outils Forma-
tage.

— Faites un clic droit sur la série de données et choisissez Formater les barres d’erreur X
ou Formater les barres d’erreur Y dans le menu contextuel.

3) Choisissez les options désirées et modifiez 'apparence des barres d’erreur dans I'onglet
Ligne. Voir ci-dessus pour plus d'informations sur ces options.

4)  Cliquez sur OK pour refermer la boite de dialogue et mettre a jour les barres d’erreur des sé-
ries sélectionnées. Si nécessaire, cliguez hors du diagramme pour quitter le mode d’'édition.

Supprimer les barres d’erreur

Pour supprimer les barres d’erreur de toutes les séries de données :

1) Sélectionnez le diagramme par un double-clic sur celui-ci pour entrer en mode d’édition. Il
doit étre entouré d’'une bordure épaisse grise.

2) Choisissez Insertion > Barres d’erreur X ou Barres d’erreur Y dans la barre de menu pour
ouvrir la boite de dialogue Barres d’erreur (Figure 49). Quand aucune série de données n’'est
sélectionnée, elle comporte I'option Aucune dans la section Catégorie d’erreur.

3) Cochez I'option Aucune.

4)  Cliquez sur OK pour refermer la boite de dialogue. Si nécessaire, cliquez hors du dia-
gramme pour quitter le mode d’édition.

Pour supprimer les barres d’erreur d'une seule série de données, procédez comme ci-dessus, sauf
a I'étape 2 : faites un clic droit sur la série de données puis sélectionnez Supprimer les barres de
données X ou Supprimer les barres de données Y dans le menu contextuel.

Ajouter des objets de dessin aux diagrammes

Utilisez la barre d’outils Dessin pour ajouter des formes comme des lignes, des rectangles, des
cercles, des objets textes ou des formes plus complexes comme des symboles ou des fléches.
Elles permettent d'ajouter des explications, de mettre en évidence des endroits du diagramme ou
méme de masquer certaines données ou certains textes.

Pour afficher la barre d’outils Dessin, sélectionnez Affichage > Barres d’outils > Dessin dans la
barre de menu. Vous pouvez la placer ou vous voulez dans I'espace de travail. Pour plus d’'infor-
mations sur 'utilisation de la barre d'outils et des outils de dessin, voir le chapitre 5, Utiliser des
éléments graphiques, ainsi que le Guide Draw.

La barre d'outils Dessin a I'apparence suivante quand le diagramme est en mode d’édition (apres
un double clic sur celui-ci).
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Avant de placer une fléche, un texte ou tout autre élément de dessin dans un diagramme,
vérifiez que celui-ci est en mode d’édition, sinon I'objet ne sera pas relié au diagramme et ne
se déplacera pas avec lui.

b4 /
\/.x 'S\A - (°°) « . . . .

'+ Sélection . Insérer une ligne /" Ligne avec fléche & la fin
L1 Insérer un rectangle O Insérer une ellipse S§* Ligne & main levée
Insérer une zone de texte |/ Légendes <> Insérer des formes de base
Symboles <> Fléches 7 Etoiles

) Légendes i Organigramme

Figure 50 : Barre d'outils Dessin quand un diagramme est en mode d’édition.

La plupart des choix se comprennent d’eux-mémes ou peuvent facilement étre retrouvés dans
I'aide, surtout en se reportant au Guide Draw. Quand vous cliquez sur une icone, I'apparence du
curseur change en relation avec cette icbne. Cliquez et tirez pour créer I'objet souhaité dans le dia-
gramme. Voici quelques informations utiles pour les diagrammes.

Insérer une lighe
Cet outil trace une ligne droite. Si vous maintenez la touche Maj enfoncée en tirant I'inclinai-
son de la ligne est limitée a un multiple de 45° si vous la tracez dans le classeur, mais cette
possibilité ne s’'applique pas aux dessins tracés dans un diagramme.

Pour écrire sur la ligne, faites un double clic sur celle-ci et tapez ou collez le texte. S'il est
trop bas, appuyez sur Entrée pour le faire monter d’'une ligne.

Insérer une zone de texte
Cet outil délimite une zone de texte écrit horizontalement. Pour incliner le texte, cliquez une
fois sur la zone de texte pour la sélectionner, faites un clic droit et choisissez Position et
taille dans le menu contextuel. Définissez I'inclinaison dans I'onglet Rotation.

Légendes
Cet outil sert & décrire ou attirer I'attention sur un point ou une zone précis du diagramme.
Cliquez a I'emplacement a indiquer dans le diagramme et tirez jusqu’a la position du texte.
Faites un double clic dans la zone de texte pour pouvoir y écrire. Le choix /- de la Figure 50
insére une légende par défaut tandis que le choix [/ ouvre une palette ol vous pouvez choi-
sir d'autres modeéles de Iégendes.

Cliguer sur les triangles v a droite des six dernieres icbnes (a I'extrémité droite de la Figure 50)
ouvre une palette d’outils avec des choix supplémentaires (Figure 51).
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Figure 51 : Les palettes d’outils accessibles par la barre d’outils Dessin

Dimensionner, déplacer et positionner un diagramme

Pour modifier les dimensions ou la position d’un diagramme, cliguez une fois sur celui-ci pour le
sélectionner. Vous pouvez effectuer ces opérations de deux facons : de maniere interactive ou en
utilisant la boite de dialogue Position et taille. 1l peut étre utile de combiner les deux méthodes :
placer rapidement le diagramme de facon interactive puis utiliser la boite de dialogue pour lui don-
ner une position et des dimensions précises.

Méthode interactive

Dimensions
Pour modifier de maniére interactive les dimensions d’un diagramme :

1) Cliguez une fois sur le diagramme pour le sélectionner. Il est alors entouré de poignées de
sélection carrées.

2) Cliguez et tirez une des poignées de sélection. Le curseur indique la direction dans laguelle
la taille du diagramme va étre augmentée ou diminuée. Si vous utilisez les poignées des
coins, le rapport d'aspect des dimensions horizontale et verticale est conservé.

3) Quand vous avez terminé, cliquez hors du diagramme pour quitter le désélectionner.
Déplacement

Pour déplacer le diagramme, utilisez une des méthodes suivantes :
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Pour des petits déplacements

1) Cliguez une fois sur le diagramme pour le sélectionner. Il est alors entouré de poignées de
sélection carrées.

2) Appuyez sur la touche Alt et une touche fléchée pour déplacer le diagramme pixel par pixel.
3) Quand vous avez terminé, cliquez hors du diagramme pour le désélectionner.
Pour des déplacements plus importants

1) Cliquez une fois sur le diagramme pour le sélectionner. Il est alors entouré de poignées de
sélection carrées.

2) Placez le pointeur de la souris au-dessus du diagramme : sa forme change (elle dépend des
parameétres de I'ordinateur).

3) Cliquez et tirez le diagramme a sa nouvelle position.
4) Relachez le bouton quand celle-ci est atteinte.

5) Quand vous avez terminé, cliquez hors du diagramme pour quitter le désélectionner.

La boite de dialogue Position et taille

La boite de dialogue Position et taille offre les options qui permettent de définir la position du dia-
gramme sur la page, sa taille, de le faire pivoter ou de I'incliner.

hﬁ
=’

=/ Remarque

La boite de dialogue Position et taille permet aussi de déplacer et de dimensionner d’autres
éléments graphiques, comme ceux créés avec la barre d’outils Dessin.

Pour modifier la taille ou la position d’un diagramme grace a la boite de dialogue Position et taille :

1) Cliquez une fois sur le diagramme pour le sélectionner. Il est alors entouré de poignées de
sélection carrées.

2) Faites un clic droit et sélectionnez Position et taille dans le menu contextuel pour ouvrir la
boite de dialogue de méme nom (Figure 52).

3) Choisissez les options souhaitées dans les onglets Position et taille, Rotation et Inclinaison
et rayons d'angles. Vous trouverez ci-dessous plus d’informations sur ceux-ci.

4)  Cliquez sur OK pour refermer la boite de dialogue et enregistrer les modifications.
5) Quand vous avez terminé, cliquez hors du diagramme pour quitter le désélectionner.

Dans I'un des schémas sous Point de base, cliqguez sur le point qui sera le point fixe utilisé pour
modifier soit la position, soit la taille.

Notez que la position ou la taille peuvent étre protégées des modifications non souhaitées en co-
chant I'option appropriée dans la section Protéger. Une fois cochées, ces options restent actives
apreés la fermeture de la boite de dialogue. En revanche, le point de base des modifications re-
prend sa valeur par défaut (en haut a gauche) quand la boite de dialogue est refermée.
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Position et taille

Position et taille Rotation Inclinaison et rayon d'angle
Position

Position X : [SRERN! Point de base :

4 F 4

Position Y : |0,55 cm

Taille

Largeur: |16,00 cm Point de base :

A4r (4 »

Hauteur: 9,00 cm

[IConserver le ratio

Protéger Adapter

| |P05iti0ﬂ Adcapter la argeur au texte

[ Taille

eur au texte

Figure 52 : I'onglet Position et taille la boite de dialogue Position et taille.

L’onglet Position et taille
Les options offertes par I'onglet Position et taille (Figure 52) sont les suivantes :

Position
Cette section permet de définir la position du diagramme sur la page par ses coordonnées
relatives a un point de base. Par défaut, celui-ci est le coin supérieur gauche du diagramme.
Pour simplifier le positionnement du diagramme, celui-ci peut étre temporairement modifié.

Position X : ce champ définit la position horizontale du point de base par rapport au bord
gauche de la colonne A.

— Position X : ce champ définit la position horizontale du point de base par rapport a la
marge gauche (qu

— Position Y : ce champ définit la position verticale du point de base par rapport au bord su-
périeur de la ligne 1.

— Point de base : spécifiez ici le point de base dont les coordonnées seront affichées et mo-
difiées dans les deux champs précédents.

Taille
Cette section permet de définir la taille du diagramme et le point de celui-ci qui doit rester
fixe au cours du redimensionnement. Par défaut, celui-ci est le coin supérieur gauche du dia-
gramme, mais il peut étre temporairement modifié.

— Largeur : ce champ définit la largeur du diagramme ou de I'objet sélectionné.
— Hauteur : ce champ définit la hauteur du diagramme ou de I'objet sélectionné.

— Conserver le ratio : cochez cette option pour que les proportions (rapport largeur / hau-
teur) du diagramme ou de I'objet soient préservées pendant le changement de dimen-
sions.
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— Point de base : spécifiez ici le point du diagramme qui doit rester fixe au cours du change-
ment de dimensions. Les autres points sont déplacés pour obtenir la largeur et la hauteur
définies dans les champs précédents.

Protéger

Ces options permettent d’éviter de modifier la position ou la taille du diagramme de facon
non intentionnelle.

— Position : cochez cette option pour éviter de modifier la position du diagramme sans le
vouloir.

— Taille : cochez cette option pour éviter de modifier la taille du diagramme sans le vouloir.

Adapter
Ces options spécifient si la taille d'un objet doit s’ajuster a celle du texte qu’il contient. Elles
s’appliquent plutét a des objets de dessin et ne sont pas disponibles pour les diagrammes.

— Adapter la largeur au texte : si cette option est cochée, la largeur de I'objet augmente, si
nécessaire, pour qu'il puisse accueillir tout le texte.

— Adapter la hauteur au texte : si cette option est cochée, la hauteur de I'objet augmente, si
nécessaire, pour qu'il puisse accueillir tout le texte.

L’onglet Rotation

Les options de I'onglet Rotation (Figure 53) sont les suivantes :

Position et taille

Position et taille Rotation Inclinaison et rayon d'angle
Point de pivot

Position X : |(AEKa Parametres par défaut :

A[ 0| (4] ¢

Position Y : |5,05 cm

Angle de rotation

Angle : 0,00 = Paramétres par défaut :
|

Figure 53 : I'onglet Rotation de la boite de dialogue Position et taille.

Point de pivot
C’est le centre de la rotation appliqguée au diagramme ; il se trouve par défaut au centre de
celui-ci. Notez que si la place manque, le diagramme peut étre déplacé hors de la page.

— Position X : ce champ définit la position horizontale du centre de rotation par rapport au
bord gauche de la colonne A.

— Position Y : ce champ définit la position verticale du centre de rotation par rapport au bord
supérieur de la ligne 1.
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— Parametres par défaut : vous pouvez choisir une des positions proposées par rapport au
diagramme pour définir le centre de la rotation que vous allez effectuer, mais celle-ci n'est
pas conservée entre deux ouvertures de la boite de dialogue, qui reprend sa valeur par
défaut au centre du diagramme.

Angle de rotation
Vous pouvez définir ici, de deux fagons, I'angle de rotation en degrés.

— Angle : ce champ indique le nombre de degrés de rotation (entre 0 et 359°). Vous pouvez
y modifier directement la valeur qu’il contient ou utiliser la roue a droite sous Parameétres
par défaut.

— Parameétres par défaut : vous avez la une représentation graphique de I'angle de rotation.
Vous pouvez cliquer et tirer le marqueur a sa périphérie pour madifier I'angle. Le champ
précédent indique I'angle en degrés.

L’onglet Inclinaison et rayons

Position et taille %

Position et taille Rotation Inclinaison et rayon d'angle

Rayon d'angle Incliner
Rayon > Angle: 0 -
Point de controle 1 Point de controle 2

e - % AR S -
A Ul cm - A U UL C =

A 0O -~ o A AN -
T, vuUu Cm - { uul C -

Figure 54 : I'onglet Inclinaison et rayon d’angle de la boite de dialogue Position et taille

La seule option accessible, dans cet onglet, pour les diagrammes est Angle dans la section Incli-
ner qui spécifie I'angle, entre —89 et +89 degrés et dans le sens des aiguilles d’'une montre, dont
est incliné le bord vertical du diagramme.

Sélectionner plusieurs diagrammes

Sélectionnez plusieurs diagrammes en cliquant une fois sur le premier puis en maintenant la
touche Maj enfoncée tout en cliguant sur les autres. Un rectangle de sélection invisible couvre
tous les diagrammes sélectionnés et des poignées de sélection apparaissent aux sommets et au
milieu des cbtés de ce rectangle. L'ensemble des diagrammes est alors traité comme un objet
unigue auqguel vous pouvez appliquer des actions telles que celles-ci :

* les couper et les coller ou les tirer a de nouveaux emplacements,
. utiliser la boite de dialogue Position et taille décrite ci-dessus,

« utiliser la barre d’outils Propriétés de I'objet de dessin pour aligner tous les diagrammes, for-
mater leurs bordures externes ou les ancrer a la méme cellule ou a la méme page.
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Modifier I'apparence globale des diagrammes

Une fois sélectionné par un clic unique, un diagramme peut étre formaté comme un objet. La barre
d’outils Propriétés de I'objet de dessin (Figure 55) apparait normalement sous la barre d’outils
Standard (mais son emplacement dépend de vos réglages) et offre des outils disponibles pour
tous les objets, y compris les diagrammes.

La plupart des fonctions sont explicites ou l'aide se trouve facilement. Veuillez vous reporter au
chapitre 5, Utiliser des éléments graphiques, de ce guide et au Guide Draw pour plus d’'informa-
tions. La suite de cette section propose quelques conseils pour l'utilisation de ces outils avec les
diagrammes.

i' t'__' [ S | |:_ ;:"'0,00cm:E,
covleur M| I - =% - ] 0 [0 2 2 [

i .0

[ B

£ Ancre < Aligner "' Envoyer a l'avant

© Vers l'avant 1 Vers l'arriere “~ Envoyer a l'arriére

= Au premier plan = Alarriére-plan Style de ligne
000cm ~ Largeur de ligne i Couleur de ligne Style de remplissage
*\ Couleur de remplissage * % Style de fléche [ Pivoter

£ Points ' Grouper 2 Entrer dans le groupe

5 Quitter le groupe ' Dégrouper

Figure 55 : la barre d’outils Propriétés des objets de dessin telle qu’elle apparait
quand un diagramme est sélectionné.

Ancre
Cette icbne permet de préciser si le diagramme occupe une position déterminée sur la page
ou s'il est lié a une cellule avec laquelle il se déplace (en cas d’insertion ou de suppression
de lignes ou de colonnes). Quand I'option A la cellule (redimensionner avec la cellule) est
choisie, la taille du diagramme (ou de I'objet) augment ou diminue avec celle de la cellule.

Aligner
Cliquez sur cette icone pour ouvrir une palette d’options vous permettant

d’aligner plusieurs diagrammes horizontalement ou verticalement. Deux dia- lﬁ = | ' |
grammes (ou autres objets) au moins doivent étre sélectionnés pour que ce _T I _J:
bouton soit actif. F U -

Envoyer a I’avant |/ Vers I’avant | Vers I'arriére | Envoyer a I'arriére
Régle I'ordre d’empilement et d’affichage des objets les uns derriére les autres.

Au premier plan | A I'arriére-plan
Place le diagramme ou le groupe d’objets au premier plan ou a l'arriére-plan. Dans Calc, ce-
lui-ci place les objets derriére la grille de cellules, ce qui peut les rendre difficiles a sélection-
ner. Utilisez I'outil Sélection (premier bouton en forme de fleche) de la barre d’outils Dessin
pour y arriver.

Style | Largeur | Couleur de ligne
Ces champs permettent de formater la bordure externe du diagramme.
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Style | Couleur de remplissage
Ces champs permettent de définir le fond d’objets comme les fleches, les formes ou les lé-
gendes. lIs ne jouent aucun réle pour les diagrammes. Pour ceux-ci, utilisez les options deé-
crites dans le mode d’édition (page 20).

Style de fleche
Ce bouton permet de définir I'apparence des terminaisons de lignes fléchées. Il ne s’applique
ni aux fleches de la Figure 51 ni aux diagrammes.

Pivoter
Ce bouton permet de faire pivoter interactivement le diagramme (voir aussi page 60). Quand
vous cliquez sur lui, le diagramme est entouré de poignées de rotation rondes a chaque
sommet. Tirez I'une de ces poignées pour faire pivoter le diagramme. Un cercle au centre du
diagramme marque le centre de rotation que vous pouvez déplacer. Tirez les poignées au
milieu des cétés pour incliner le diagramme verticalement ou horizontalement.

Points
Vous permet de modifier la forme des courbes créées avec les outils de la barre d’outils Des-
sin. Cela ne s'appligue pas aux diagrammes.

Outils de groupe
Ces outils permettent de grouper, ou dégrouper, deux objets ou plus. Une fois groupés, les
objets peuvent étre déplacés ensemble et des modifications simultanées peuvent leur étre
appliquées.

Copier, exporter et supprimer des diagrammes

Coller des diagrammes dans le méme classeur

Quand un diagramme est copié, le lien qu'il a avec la source de données a partir de laquelle il a
été construit est maintenu tant que cela reste dans le méme document. Cela signifie que les modi-
fications apportées a la source de données seront reflétées dans le diagramme.

Copier et coller le diagramme est tout simple : il suffit de cliquer une fois sur celui-ci pour le sélec-
tionner puis d’appuyer sur Ctr 1+C, de choisir Copier dans le menu Edition ou dans le menu
contextuel aprés un clic droit, ou de cliquer sur l'icone Copier (52 dans la barre d'outils Standard.
Pour le coller & 'emplacement désiré, appuyez sur Ctr 1+V, choisissez Coller dans le menu Edi-
tion ou dans le menu contextuel aprés un clic droit, ou cliquez sur I'icone Coller (| 4) dans la barre
d’outils Standard.

Coller dans un autre document de LibreOffice

Quand un diagramme est copié et collé dans un autre document de LibreOffice, tout lien avec les
données sur lesquelles il a été construit est perdu. Les données sont conservées avec le dia-
gramme dans une table de données, au lieu d’'une plage de données. La Figure 56 montre un
exemple d’'une telle table de données interne.
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Eg Remarque

Un diagramme n’est associé a sa plage ou sa table de données que s'il est collé dans un
document de LibreOffice. Pour conserver cette association a I'extérieur de LibreOffice, utili-
sez l'incorporation ou la liaison, comme expliqué dans le chapitre 10, Lier les données.

Conserver les données d’origine

Si vous avez l'intention d'utiliser les données d’origine avec le diagramme, il suffit d’'employer la

procédure précédente pour copier et coller le diagramme dans 'autre document. Rien d'autre n'est
nécessaire.

Modifier les données d’origine
Si les données d’origine du diagramme doivent étre modifiées, procédez de la fagon suivante :

1) Sélectionnez le diagramme par un double clic sur celui-ci pour entrer en mode d’édition. Il
doit étre entouré d’'une bordure épaisse grise.

2) Faites un clic droit sur le diagramme et sélectionnez Table de données dans le menu
contextuel pour ouvrir la boite de dialogue visible sur la Figure 56.

Table de données 3

& 57 57 % 0% | B 5= BR
i, Canoés a_ |Bateaux n_ Rafts
S

Catégories | Valeurs Y Valeurs Y Valeurs Y

1 [Janvier 12 23 47

2 |Février 9 31 54

3 |Mars 14 27 56

4 |Avril 17 28 48

5 |Mai 13 19 39

6 |Juin 8 27 52

Figure 56 : Table de données associée a un diagramme copié dans un autre document

3) Modifiez les données que vous désirez. Vous pouvez aussi utiliser les icones en haut de la
boite de dialogue pour insérer, déplacer ou supprimer des lignes ou des colonnes.

4)  Cliquez sur OK pour refermer la boite de dialogue. Si nécessaire, cliquez hors du dia-
gramme pour quitter le mode d’édition.

Replacer des données par tirer-glisser

Si le diagramme est encore dans Calc et les données de remplacement dans le méme classeur,
sélectionnez les nouvelles données et tirez-les sur le diagramme. Cette méthode est décrite dans
« Remplacer les données par tirer-glisser », page 21.

Eg Remarque

Calc n'offre aucun moyen direct pour enregistrer les paramétres d’'un diagramme en vue de
les utiliser pour créer d’autres diagrammes dans LibreOffice. Voici trois méthodes qui per-
mettent d'utiliser les paramétres d’'un diagramme :
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— copier et coller le diagramme dans un autre fichier,
— enregistrer le fichier contenant le diagramme sous un autre nom,
— enregistrer le diagramme dans un modéle.

Selon la méthode utilisée, créez le nouveau diagramme en modifiant les données dans la
table ou la plage de données.

Exporter I'image d’un diagramme

Les diagrammes peuvent étre exportés vers d’autres documents dans de nhombreux formats
d’'image. Parmi les types de fichiers possibles, BMP, EMF, EPS, GIF, JPEG, PDF, PNG, SVG,
SVM, TIFF et WMF.

Pour exporter un diagramme dans un format d’'image :

1) Cliquez une fois sur le diagramme pour le sélectionner. Il est alors entouré de poignées de
sélection carrées.

2) Faites un clic droit sur le diagramme sélectionné puis choisissez Exporter comme image
dans le menu contextuel.

3) Dans la boite de dialogue, saisissez le nom du fichier d'image, sélectionnez son emplace-
ment et le format de ce fichier.

4)  Cliquez sur Enregistrer pour exporter I'image du diagramme a I'emplacement choisi.

Supprimer des diagrammes

Pour supprimer un diagramme, cliquez une fois sur le diagramme pour le sélectionner, il est alors
entouré de poignées de sélection carrées, puis appuyez sur la touche Suppr.

Galerie de types de diagrammes

Bien que les données puissent étre représentées par un grand nombre de diagrammes, c’est le
message qu'il doit véhiculer qui détermine le type de diagramme a utiliser. La présente section
offre des exemples des types de diagrammes proposés par Calc accompagnés de quelques re-
marques sur leurs utilisations.

Diagrammes en colonnes

Un diagramme en colonnes affiche des barres verticales dont la hauteur est proportionnelle a la
valeur représentée. L'axe X indique les catégories et I'axe Y la valeur de chaque catégorie (voir Fi-
gure 2).

Les diagrammes en colonnes sont couramment utilisés pour montrer des tendances dans le
temps. C’est le type de diagramme proposé par défaut par Calc, car c’est un des plus utiles et des
plus simples a comprendre. lls conviennent mieux pour un nombre relativement petit de points de
données. Pour de plus longues séries, un diagramme en lignes est plus approprié.

Le type de diagramme en colonnes possede trois variantes dont un apercu est proposé par la
boite de dialogue comme sur la Figure 57. Pour sélectionner une variante, cliquez sur son apergu
qui s’entoure d’'une double bordure ; son nom apparait sous les apergus.
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Les variantes 2D sont les suivantes :

Normal
Toutes les valeurs des données appartenant a une catégorie sont affichées les unes a coté
des autres. L'accent est mis sur la comparaison des valeurs absolues individuelles les unes
par rapport aux autres.

Empilé
Toutes les valeurs des données appartenant a une catégorie sont affichées les unes au-des-
sus des autres. L'accent est mis sur la valeur totale de chaque catégorie et sur la contribu-
tion de chaque valeur a I'intérieur d’'une catégorie.

Pourcentage empilé
Tous les pourcentages des valeurs d’'une catégorie, par rapport au total de la catégorie) sont
affichés les uns au-dessus des autres. Toutes les barres ont la méme hauteur. L’'accent est
mis sur la contribution de chaque valeur au total de la catégorie. (Contrairement a ce que
laisse penser I'apercu sur la Figure 57, les pourcentages sont empilés et non représentés
cOte a cote.)

Type de diagramme

= Barre

Secteur ‘ I l
= 7one L
-~ Ligne
|- XY (dispersion) Normal
|-~ Bulle 13D |Réaliste

L Toile Forme

Pk pare |8

n_ Colonne et ligne [Edtindia

Pyramide

Figure 57 : la boite de dialogue Type de diagramme : Colonne
Une variante et deux options supplémentaires sont disponibles en cochant la case 3D :

Aspect 3D
Quand cette option est cochée, une quatriéme variante est proposée avec la dénomination
Profond qui affiche les valeurs des données de chaque catégorie alignées les unes derriere
les autres.

Deux choix sont offerts dans la liste déroulante :
— Réaliste qui essaie d'offrir la meilleure représentation en 3D,
— Simple qui essaie d'imiter I'aspect offert par d’autres produits.

Forme
La liste offre quatre choix de formes pour la colonne : Barre, Cylindre, Cbne et Pyramide.
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Diagrammes en barres

Un diagramme en barres ressemble a un diagramme en colonne qu’on a fait tourner de 90°. Il af-
fiche des barres horizontales & la place de colonnes verticales. A 'opposé des autres types de dia-
grammes, I'axe Y est horizontal et I'axe X vertical. La boite de dialogue pour ce type de dia-
gramme est pour I'essentiel identique a celle du diagramme en colonnes décrite ci-dessus.

Les diagrammes en barre ont un impact visuel immédiat quand le temps n’est pas un facteur im-
portant, par exemple quand il s'agit de comparer la popularité de quelques produits sur le marché.
On peut les préférer aux diagrammes en colonnes quand les noms des catégories sont longs ou
guand le nombre de celles-ci est important.

Dans les exemples de la Figure 58 ci-dessous,

Parts de marché Parts de marché Parts de marché
= ABC 0 5 10 15 20 25 30 35 40 45
DEF ®ABC
DEF DEF —————— 33
JKL mJKL
W Autres JKL 45
Autres
Autres E==e=—"t o

0 5 10 15 20 25 30 35 40 45 50 0 5 10 15 20 25 30 35 40 45 50

Figure 58 : Exemples de diagrammes en barres.

*  Pour réaliser le premier diagramme, aprés avoir utilisé I'assistant de diagramme, sélection-
nez Insertion > Grilles et décochez Axe Y, puis sélectionnez Insertion > Courbes de va-
leur moyenne. Faites un clic droit sur chaque courbe de valeur moyenne et sélectionnez
Formater la courbe de valeur moyenne pour augmenter sa largeur. Avec la barre d’outils
Dessin, tracez des rectangles pour couvrir les entrées correspondant a ces courbes dans la
légende. Donnez-leur une couleur blanche en faisant un clic droit puis en sélectionnant
Ligne puis Remplissage dans le menu contextuel et en choisissant la couleur blanche.

* Le deuxieme diagramme est en 3D, créé avec une bordure simple et une forme cylindrique.
La paroi du diagramme est pivotée (selon la méthode décrite dans « Rotation et perspec-
tive », page 44).

* Dans le troisieme diagramme, la légende est supprimée au profit des étiquettes sur I'axe X.
Alors que les deux premiers traitent les données en séries séparées, celui-ci les traite en une
série unique pour avoir des étiquettes de catégories sur I'axe X. A la place de couleurs, un
motif de hachures horizontales est utilisé pour les barres.

Diagrammes en secteurs

Un diagramme en secteurs représente les valeurs par des secteurs circulaires dont les aires sont
proportionnelles a ces valeurs.

Les diagrammes en secteurs sont parfaits pour comparer des proportions, par exemple la réparti-
tion d'un budget entre postes. lIs conviennent bien pour de petits nombres de valeurs, jusqu’a une
demi-douzaine environ ; plus nombreuses, I'impact visuel tend a s’affaiblir.
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Type de diagramme X

[a! Colonne
= Barre
AANANO O
ke Zone
[~ Ligne

[-* XY (dispersion) Normal

- Bul =
ITT:”: (13D [Réaliste

[t Cours
|2 Colonne et ligne

Figure 59 : La boite de dialogue Type de diagramme pour les secteurs.
La Figure 59 montre les variantes des diagrammes en secteurs :

Normal
Les valeurs sont représentées par des secteurs d’'un disque complet, avec la possibilité d’'en
séparer les éléments individuels. Cliquez sur la bordure externe d’'un secteur pour le séparer
du reste du disque ou pour I'y ramener.

Diagramme en secteur éclaté
Les secteurs sont séparés les uns des autres et vous pouvez cliquer sur chaque secteur et
le tirer le long d’un rayon pour I'écarter du centre.

Tore
Le diagramme en secteurs de tores permet de représenter plusieurs séries de données
comme des tores emboités. Cliquez sur un secteur externe et tirez-le pour le déplacer le
long d’'un rayon et I'écarter du centre.

Diagramme tore éclaté
Dans ce cas, les sections extérieures sont déja séparées des autres. Cliquez sur un secteur
externe et tirez-le pour le déplacer le long d’un rayon et I'écarter du centre.

A son ouverture, I'assistant de diagramme essaie de deviner comment représenter les données
dans le diagramme. Vous pouvez y apporter des ajustements dans la page Plage de données ou
Séries de données de l'assistant de diagramme ou en utilisant la boite de dialogue Plages de don-
nées (Format > Plages de données).

Il est possible de faire des choses intéressantes avec un diagramme en secteurs, surtout en 3D. I
peut étre inclingé, recevoir une ombre et transformé en ceuvre d’art. Il suffit de ne pas trop le sur-
charger au risque de perdre le message a transmettre et de rester prudent en l'inclinant pour ne
pas déformer les tailles relatives des secteurs.

Vous pouvez choisir la variante en secteurs éclatés, mais toutes les pieces sont séparees les unes
des autres (contrairement a ce que laisse penser I'apercu de la Figure 59). Si votre but est de
mettre en évidence un seul secteur, séparez-la en le sélectionnant puis en le tirant hors du disque,
aprés quoi il faudra peut-étre agrandir le diagramme pour retrouver la taille initiale des éléments.

Les exemples de la Figure 60 ont été obtenus de la maniéere suivante :

Diagramme en 2D avec un secteur écarté
Sélectionnez Insertion > Légende et décochez Afficher la Iégende. Sélectionnez Insertion
> Etiquettes de données Cochez Afficher la valeur sous forme de nombre et Afficher la ca-
tégorie. Dans les listes Séparateur et Placement, choisissez Nouvelle ligne et Extérieur. Cli-
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guez sur le bord du secteur (il doit étre entouré de poignées carrées) et éloignez-le des
autres secteurs. Leurs tailles diminuent, donc, si nécessaire, sélectionnez la paroi du dia-
gramme et tirez un sommet pour en augmenter la taille.

Budget prévisionnel Budget prévisionnel
Déplacements 12%
Charges 40 000,00 € 4%
15 000,00 € m Déplacements
]
Fournitures Salaires 14%9 3% lc::gj:rg]i(tajres
150 000,00 € .
50 000,00 € 7 Equipement
# Salaires
Equipement 26 %
90 000,00 €

Figure 60 : Exemples de diagrammes en secteurs.

Diagramme en 3D, variante secteurs éclatés, 3D réaliste et effets de remplissage divers
Sélectionnez Format > Type de diagramme et cochez 3D (Réaliste est le choix par défaut).
Sélectionnez Insertion > Etiquettes de données et cochez Afficher la valeur sous forme de
pourcentage. Sélectionnez ensuite chaque secteur, qui doit étre entouré de poignées car-
rées, faites un clic droit et choisissez Formater le point de données dans le menu contex-
tuel. La Figure 60 montre un secteur obtenu en choisissant un Bitmap dans I'onglet Zone, un
autre obtenu en choisissant un Motif et les deux derniers en choisissant 50 % dans I'onglet
Transparence et un dégradé radial dans le méme onglet.

Budget prévisionnel Budget prévisionnel

B Déplacements

B Charges B Déplacements
O Fournitures W Charges

L Fournitures
H Equipement m Equipement
W Salaires ® Salaires

Figure 61 : Exemples de diagrammes en tores.

Les variantes Tore et Diagramme Tore éclaté, visibles sur la Figure 61, sont utilisées pour afficher
deux séries d’'informations reliées, comme les budgets de deux années. Cette variante peut induire
en erreur si on compare des valeurs numériques absolues, car le tore intérieur est nécessairement
plus petit que le tore extérieur. Pour plus de variété, utilisez I'aspect 3D.

Diagrammes en zones

Comme les diagrammes en lignes ou en colonnes, un diagramme en zones affiche les valeurs sur
'axe Y et les catégories sur I'axe X. Les valeurs des points de données de chaque série sont re-
liees par des lignes et les surfaces sous ces lignes sont colorées.

Les diagrammes en zones mettent en valeur I'importance des changements d’une catégorie a
l'autre. Leur impact visuel est plus fort que celui des diagrammes en lignes, mais ce sont les don-
nées utilisées qui font la différence.
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Normal Profond

[13D |Réaliste ‘ ‘Réaliste_ V_.
Figure 62 : Apercu des diagrammes en zones 2D et 3D

dans la boite de dialogue Type de diagramme.
Les variantes de diagrammes en zones visibles sur la Figure 62 sont les suivantes :

Normal
Les hauteurs des points sont proportionnelles aux valeurs de la série de données. Le tracé
commence par la derniére série de la plage de données et continue jusqu’a la premiéere qui
est dessinée par-dessus toutes les autres. Les valeurs les plus élevées de la premiere série
vont donc masquer les valeurs plus petites des suivantes.

Profond
Cette variante en 3D correspond a la variante normale en 2D. La premiére série de données
est dessinée devant puis les suivantes les unes derriére les autres.

Empilé
Les valeurs sont empilées les unes sur les autres : la hauteur d’'un point de donnée est pro-
portionnelle a la somme de sa valeur et de toutes celles du point correspondant dans les sé-
ries précédentes. De cette maniére, toutes les valeurs sont visibles et aucune donnée n’est
masquée par une autre, mais les hauteurs le long de I'axe Y ne représentent plus directe-
ment les valeurs des points de données, sauf pour la premiére série qui apparait en bas de
'empilement.

Pourcentage empilé
Les valeurs empilées sont les pourcentages représentés par chaque point de données par
rapport a la somme des points de données correspondants dans toutes les séries. Le total
est donc toujours 100 %.

Hauteur de neige Hauteur de neige Hauteur de neige

300 300 300
250 250
200 200
150 150
100 100

50 50

0 0
Décembre Janvier Février Mars Avril Décembre Janvier Février Mars Avril

mLa Plagne ® Les Moulis * Courmayeur ©La Plagne ELes Moulis O Courmayeur

Figure 63 : Exemples de diagrammes en zones

Diagrammes en zones normales

Les diagrammes en zones sont parfois un peu délicats a construire. L'utilisation de la transparence
peut étre une aide précieuse. Pour créer les diagrammes de la Figure 63, la premiére étape
consiste a définir le diagramme de base grace a l'assistant de diagramme. Le résultat est visible a
gauche. Comme les données se recouvrent, certaines disparaissent les unes derriére les autres,
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ce qui n'est probablement pas l'effet souhaité. Les autres exemples proposent de meilleures solu-
tions.

*  Pour créer le diagramme central, aprés avoir supprimé la grille de I'axe Y, faites un clic droit
sur chaque série de données et sélectionnez Formater les séries de données dans le
menu contextuel. Dans I'onglet Transparence, cochez I'option Transparence 50 %. Il est ain-
si plus facile de voir les données cachées derriere la premiére série.

*  Pour créer le diagramme de droite, apres avoir créé le diagramme précédent, faites un clic
droit et sélectionnez Type de diagramme dans le menu contextuel. Cochez I'option 3D et
sélectionnez I'aspect Réaliste dans la liste déroulante. Faites pivoter le diagramme avec la
boite de dialogue Affichage 3D et remplacez la Iégende par des étiquettes sur I'axe Z.

Diagrammes de zones empilées

Une autre maniére de représenter les séries de données consiste a utiliser des zones empilées, en
valeurs absolues ou en pourcentages (Figure 64). Dans le premier exemple, la valeur de chaque
point d’'une série de données est ajoutée a celles des points correspondants des séries qui la pré-
céde pour déterminer sa hauteur sur I'axe Y. Dans le deuxiéme exemple, c’est le pourcentage de
cette somme par rapport au total qui détermine la position du point. La derniére série culmine donc
toujours a 100 %.

Consommation énergétique mondiale Consommation énergétique mondiale

en milliers de TWh (source Wikipedia) en milliers de TWh (source Wikipedia)

70 100 %

60 B Charbon 90 % B Charbon

H Pétrole 80 % H Pétrole

50 u Gaz 70 % m Gaz

40 Hydroélectricité 60 % Hydroélectricité
B Nucléaire 50 % ® Nucléaire

30 B Renouvelable 40 % B Renouvelable

20 30 %
0
10 20 %

10 %
e  ———8) R
0 0%
1970 1980 1990 2000 2010 2019 3.970 1980 1990 2000 2010 2019
Figure 64 : Exemples de diagrammes en zones empilées,

en valeurs a gauche, en pourcentages a droite.

Diagrammes en lignhes

Un diagramme en ligne est utile pour montrer des tendances ou des changements au cours du
temps quand vous voulez mettre I'accent sur la continuité. Les valeurs apparaissent comme des
points de I'axe Y et I'axe X affiche les catégories, souvent des séries de données temporelles. Les
points de chaque série de données peuvent étre reliés par une ligne.
:g Remarque
A la différence des diagrammes en lignes décrits dans cette section qui affichent des caté-
gories le long de I'axe X, les diagrammes XY (dispersion) affichent des valeurs le long de
cet axe.

Comme le montre la Figure 65, quatre variantes sont possibles :

Points seuls
qui n'affiche que les points de données.
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Points et lignes
qui affiche les points de données reliés par des lignes dans la méme série de données.

Lignes seules
qui n’affiche que les lignes.

Lignes 3D
qui relie les points de la méme série de données par des rubans en 3D.

Type de diagramme X

la_ Colonne
= Barre s 2 o~ A~ o~

Secteur :
ke Zone
l-* XY (dispersion) Points et lignes
|- Bulle
L Toile
l._ Cours f?i'gn haut
lii Colonne etligne | O Pourcentage

[vSéries empilées

Type de ligne Lissée |~ | Propriétés...

Figure 65 : La boite de dialogue Type de diagramme : lignes lissées avec séries empilées.

Quand l'option Séries empilées est cochée, le diagramme montre les valeurs cumulées de chaque
série les unes au-dessus des autres. Il y a deux choix possibles :

En haut
les valeurs absolues sont représentées les unes au-dessus des autres. Les hauteurs des
points de données ne représentent plus leurs valeurs, sauf pour la premiére série qui appa-
rait en bas du diagramme. C’est le choix par défaut.

Pourcentage
empile les pourcentages des valeurs par rapport au total des points de données équivalents
de chaque série.

La liste déroulante Type de ligne offre trois options qui déterminent la fagon dont les points de don-
nées sont reliés :

Direct
Les points sont reliés par des lignes droites.
Lissée
Les points sont reliés par des lignes courbes. Quand cette option est sélectionnée, cliquer

sur Propriétés ouvre la boite de dialogue Lignes lisses (Figure 66) ou vous pouvez définir
plus précisément les courbes.

Deux options sont possibles :

— Spline cubique interpole entre les points de données par des polyndmes de degré 3. Les
transitions entre les arcs sont lisses, car elles ont la méme pente et la méme courbure.

— Résolution détermine le nombre de segments calculés pour tracer un arc de polynédme
entre deux points de données. Sa valeur s'étend de 1 a 100. Cliquez sur une série de
données pour voir les points intermédiaires.

72 | Chapitre 3 — Créer des diagrammes et des graphiques



— Spline B utilise des courbes splines B paramétriques pour I'interpolation. Elles sont
construites a partir de polynémes dont le degré (entre 1 et 15) est défini par Degré de po-
lynomiales.

Lignes lisses

Type de ligne : CIcL:ANG—_—
Résolution :

Degré de polynomiales : 3 =

Aide Annuler

Figure 66 : la boite de dialogue Lignes lisses.

Escalier
Les points sont reliés par des segments exclusivement horizontaux ou verticaux. Cliquez sur
Propriétés pour préciser le formatage des lignes (Figure 67). Les options sont explicites.

Lignes en escalier X

Type de pas

O Pas 4 la moyenne horizontale (O Pas a la moyenne verticale

Aide Annuler

Figure 67 : la boite de dialogue Lignes en escalier.

Consommation énergétique mondiale Consommation énergétique mondiale
0 en milliers de TWh (source Wikipedia) ) en milliers de TWh (source Wikipedia)
7 5
60 20
50
40 15
20
10 ° —
0 M—————— 1—2@ 0 .———-——é .:—I7.
1970 1980 1990 2000 2010 2019 1970 1980 1990 2000 2010 2019
== Renouvelable === Nucléaire Hydroélectricité == Renouvelable ==#=— Nucléaire Hydroélectricité
== Gaz =—@— Pétrole == Charbon =i Gaz =—8— Pétrole === Charbon

Figure 68 : Exemples de diagrammes en lignes, empilés (a gauche) ou non (a droite).

Que faire avec les lignes : les épaissir, lisser le tracé, n'afficher que les points ou les tracer en 3D.
Cependant, les lignes en 3D peuvent perturber le lecteur, si bien qu’une ligne plus épaisse est sou-
vent plus efficace.

Diagrammes de dispersion ou XY

Par opposition aux diagrammes en lignes, colonnes ou barres qui représentent des valeurs sur
'axe Y et des catégories sur I'axe X, les diagrammes de dispersion ou XY représentent des va-
leurs sur les deux axes. lls sont assez utiles, surtout pour comprendre les relations entre les don-
nées, qui peuvent étre précises et complexes. Un diagramme XY peut contenir plus d’'une série de
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données et peut réaliser de nombreuses taches, comme générer une courbe paramétrique ou re-
présenter le graphe d’une fonction.

/Q‘ Conseil
Avant de représenter des dates sur I'axe X, vérifiez qu’elles ne sont pas sous forme de texte
et gu’elles sont écrites conformément aux paramétres de la langue locale. Par exemple, a la
place de Janvier, utilisez un format comme 1/1/2020. Vérifiez les formats acceptés a la page

Parametres linguistiques — Langue de la boite de dialogue Options (Outils > Options > Pa-

ramétres linguistiques > Langues dans la barre de menu), dans la rubrique Formats de
dates acceptés.

Les diagrammes XY sont le plus souvent utilisés pour étudier les associations statistiques entre
variables quantitatives. Il y a souvent une valeur constante par rapport a laquelle comparer les
données, par exemple des données météorologiques, des réactions selon le niveau d’'acidité ou
les conditions a diverses altitudes.

’Q\ Conseil

Par convention, si une des variables est contrblée par un expérimentateur ou change de

maniére systématique (comme le temps), elle est considérée comme variable indépendante
et placée sur I'axe X.

Variantes de diagrammes XY

Comme le montre la Figure 69, quand le type de diagramme XY (dispersion) est sélectionné, les
options suivantes peuvent étre disponibles :

Type de diagramme

[a. Colonne
& Barre . |
Secteur
ks Zone
E Ligne
Points et lignes
|<* Bulle . -
L Toile Type de ligne [Direct |~| | Propriétés...
la° Cours 5 :
lai Colonne et ligne

Figure 69 : Type de diagramme XY (dispersion).

Points seuls
Cette variante affiche une icone pour chaque point de données. Calc utilise les icbnes par
défaut avec une forme et une couleur différente pour chaque série. Les couleurs par défaut
sont définies dans la page Diagrammes — Couleurs par défaut de la boite de dialogue Op-
tions (Outils > Options > Diagrammes > Couleurs par défaut dans la barre de menu). La
modification des couleurs et des icones est expliqguée dans la section « Lignes, zones et
icones des points de données », page 26.
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Lignes seules
Dans cette variante des lignes droites joignent un point d’'une série au suivant. Aucune icbne
n'indique I'emplacement du point de données. L'ordre de tracé par défaut est celui de la série
de données, mais une option permet de Trier par valeurs X.

Points et lignes
Cette variante combine les deux précédentes.

Lignes 3D
Cette variante est semblable a Lignes seules, mais les lignes sont représentées par des ru-
bans en 3D. Une fois le diagramme terminé, sélectionnez Format > Affichage 3D pour défi-
nir les propriétés telles que I'éclairage, I'angle de vue... (voir page 43).

Cette variante est semblable a Lignes seules, mais les lignes sont représentées par des ru-
bans en 3D. Une fois le diagramme terminé, sélectionnez Format > Affichage 3D pour défi-
nir les propriétés telles que I'éclairage, I'angle de vue...

Trier par valeurs X
Si cette option est cochée, les lignes sont tracées dans I'ordre croissant des valeurs de la sé-
rie X, ce qui peut étre utile si celles-ci ne sont pas triées dans le classeur.

Type de ligne
Cette option détermine le type de ligne qui relie les points de données. Les choix possibles,
Direct, Lissée et Escalier, ont été présentés avec les diagrammes en lignes (voir « Type de
ligne », page 72).

Aprés création du diagramme, ses parametres par défaut peuvent étre modifiés de diverses fa-
cons. N'oubliez pas de commencer par un double clic sur le diagramme pour le mettre en mode
d’édition. Selon 'option a modifier, un double clic sur un point ou une série de données peut aussi
étre nécessaire.

«  Styles de lignes et d’icbnes : faites un double-clic ou un clic droit sur une série de données
pour ouvrir la boite de dialogue Série de données. Voir « Lignes, zones et icones des
points de données », page 26, pour plus d’'informations.

«  Barres d’erreur : pour les diagrammes en 2D, sélectionnez Insertion > Barres d’erreur X ou
Barres d’erreur Y. Voir « Barres d’erreur », page 52, pour plus d’informations.

*  Courbe de tendance et de valeur moyenne : utilisez les commandes du menu Insertion. Voir
« Courbes de tendance et de valeurs moyennes », page 46, pour plus d’informations.

Exemples de diagramme XY ou de dispersion

Par défaut, la premiére colonne ou ligne de données (selon la disposition) est représentée sur
'axe X. Les valeurs des autres seront représentées sur l'axe Y.

Les diagrammes de dispersion peuvent surprendre ceux qui n’en ont pas I'habitude. Cela se voit
dans les exemples qui utilisent les données suivantes, ou les séries sont disposées en lignes :

Mois 04 05 06 07 08 09 10 11
Yen 102 105 178 165 122 98 134 97
Dollar 56 57 67 90 64 56 78 34
Roupie 200 230 256 231 201 199 230 223
Yuan 69 78 75 76 69 95 69 70
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Figure 70 : Exemples de diagrammes XY (dispersion).

La plage de données du diagramme de gauche sur la Figure 70 inclut les cellules qui contiennent
les numéros des mois ; ces cellules sont formatées comme date avec le format personnalisé MM.
Si vous utilisez les noms des mois, Calc les remplacera automatiguement par la série 0, 1, 2...
jusque 9.

La plage de données du diagramme de droite n’inclut pas ces cellules. Calc utilise donc la pre-
miére ligne (les séries de données sont en lignes) pour graduer I'axe X. Les valeurs des autres sé-
ries de données sont associées a celles de la premiére ligne pour déterminer les coordonnées de
l'icbne affichée. Cela signifie qu'il n’y a pas de points de données pour le Yen, mais que les autres
sont placées par rapport a celui-ci puisque ses valeurs définissent les abscisses.

Diagrammes en bulles

Un diagramme en bulles est une variante d’'un diagramme de dispersion qui permet de visualiser
trois variables en deux dimensions. Les points de données sont représentés par des disques
(bulles). Deux variables servent a graduer les axes X et Y, alors que la troisieme est représentée
par le diamétre des disques. Ce type de diagramme est souvent utilisé pour représenter des don-
nées financiéres, sociales ou démographiques.

Une série de données ou plus peut étre incluse dans un seul diagramme. La boite de dialogue
Plage de données pour un diagramme en bulles posséde une entrée ou vous pouvez définir la
plage qui détermine la taille des disques (Figure 71). |l peut étre nécessaire de la paramétrer ma-
nuellement.

Plage de données Séries de données : .
Séries de données : Plage de données : | A | B ! € | D | E |
I (couleur de remplissage ~| | 1 | Ventes realisées et heures travaillées par jour
[Marie [ [Nom $Feuille1.$BS2 [| 2 Jour Jean Marie
| Tailles des bulles $Feuille1.$C$4:3C$12 3 Heures Heures
[Valeurs X $Feuille1.$AS4:5A512 Ventes Travaillées Ventes Travaillées
|Valeurs Y $Feuille1.5B34:38%12 ¥l | 4 1 4 6 1) 4
Plage pour Tailles des bulles 5 2 7 T 2 5
$Feuille1.$C84:$C512 = 6 3 12 9 7 6
Etiquettes de données | 7 4 15 8 23 10
= 8 5 21 9 31 11
. 9 6 7 7 16 9
Ajouter 10 7 9 6 12 7
Supprimer + 11 8 10 8 7 5
12 9 2 5 7 5

Figure 71 : Séries de données pour un dagramme en bulles.

Le diagramme de la Figure 72 s’appuie sur les données de la Figure 71. Pour le formater, les sé-
ries de données possedent un dégradé de transparence radial de 50 %. Les étiquettes de données
sont paramétrées pour étre aux centres des points de données (disques).
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Figure 72 : Exemple de diagramme en bulles.

Eg Remarque

N’oubliez pas que les diagrammes en bulles nécessitent des données numériques. Si la sé-
rie de données pour I'axe X contient du texte, ou des dates non formatées comme nombres,
des nombres entiers seront utilisés comme étiquettes de I'axe X.

Diagramme en toile

Les diagrammes en toile sont aussi appelés diagrammes polaires, en radar ou en toile d’araignée.
lIs affichent les valeurs des données a I'extrémité de rayons qui représentent chacun une variable.
lls permettent de comparer des données qui ne sont pas rangées selon une date mais selon diffé-
rentes circonstances, telles que les variables d’'une expérience scientifique. Ils sont particuliere-
ment utiles pour afficher des groupements et des cas particuliers.

La Figure 73 présente un exemple de diagramme en toile simple. Les rayons de la toile sont équi-
valents aux axes Y des autres diagrammes. Toutes les valeurs sont affichées a la méme échelle,
aussi doivent-elles avoir a peu prés la méme amplitude.

Distribution de I'espece X

Nord
Nord-ouest 100 Nord-est
- 50 &
" m
Ouest B e 0 H e Est
b 4
u |
< *
Sud-ouest Sud-est

Sud

M Avril ¢ Octobre
Figure 73 : Exemple de diagramme en toile simple.

Il vaut généralement mieux ne pas dépasser 8 rayons pour le diagramme, plus nombreux, ils le
rendent confus. On peut représenter sur le méme diagramme des valeurs avant et aprés ou des
valeurs attendues et réalisées pour pouvoir comparer les différences.
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[l Colonne et ligne ) Pourcentage
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Figure 74 : Variantes et options du type de dialogue en toile.

La Figure 74 montre les options offertes pour les diagrammes en toiles. Elles sont semblables a
celles décrites pour les diagrammes en zones et en lignes décrites précédemment. N'oubliez ce-
pendant pas que 'aire augmente comme le carré de la distance le long du rayon et donc que ce
type de diagramme peut déformer les surfaces qui représentent les données. Faites-y particuliére-
ment attention si vous choisissez des séries empilées : les séries de données successives af-
fichent des données par des aires qui deviennent de plus en plus grandes mais ne sont pas pro-

portionnelles aux valeurs.

La Figure 75 propose des exemples de deux sortes de diagrammes en toiles.

*  L'exemple de gauche est un diagramme plein. La transparence d’une des séries de données
a été réglée a 50 %, ce qui est souvent un moyen pour mieux voir toutes les données.

*  L'exemple de droite est un diagramme avec lignes et points. Les icbnes de ces points pro-
viennent de la galerie et ont été choisies avec un aspect 3D.

Budget prévisionnel et budget réalisé
Déplacements

150000

100000

Salaires Equipement

Charges Fournitures

I Réalisé M Prévisionnel

Budget prévisionnel et budget réalisé

Déplacements
150000
100000
Salaires g g 50000 Equipement
Charges Fournitures

@ Réalisé =@ Prévisionnel

Figure 75 : Exemple de diagrammes en toile plein (a gauche)
et avec des icbnes pour les points de données (a droite).

Diagramme de cours

Un diagramme de cours illustre les tendances du marché des actions en donnant le prix a I'ouver-
ture, le prix le plus bas, le prix de plus haut et le prix a la fermeture. Le volume de transaction peut
aussi apparaitre et I'axe des X représente normalement une série temporelle.

Pour définir un diagramme de cours dans l'assistant de diagramme, les données doivent étre dis-
posées comme sur la Figure 76. Elle précise les colonnes a utiliser pour le cours d’ouverture, le
plus bas, le plus haut et de cléture des actions, ainsi que le volume de transactions. Des ajuste-
ments manuels peuvent cependant étre nécessaires pour définir les séries de données.
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Acme Ajax
Volume OQuverture Plus bas Plus haut Cléture Volume Ouverture Plus bas Plus haut Clature

Lundi 2500 20 15 25 17 1700 15 10 20 17
Mardi 3500 32 22 37 30 2700 25 5 25 16
mercredi 1000 25 15 17 17 4100 14 7 17 10
jeudi 2200 40 30 47 35 3300 20 12 26 19
vendredi 4600 27 20 32 31 3500 28 16 32 21

Figure 76 : Exemple de disposition des données pour un diagramme de cours.

Un diagramme de cours organise les séries de données de deux fagons de base. La premiere
n'est pas utilisée dans d’autres types de diagrammes. Dans ce cas, les valeurs d’ouverture, au
plus bas, au plus haut et & la cléture d’'une ligne créent une unité de donnée dans le diagramme et
une série de données est constituée de plusieurs lignes contenant de telles unités de données.
Dans le second cas, les colonnes qui contiennent les volumes de transaction sont utilisées pour
organiser les séries de données, a la maniére des autres types de diagrammes.

Ainsi, la Figure 76 montre les données de quatre séries :

1) les prix des actions Acme avec des colonnes pour le prix d’ouverture, le plus bas, le plus
haut et le prix de cléture,

2) les prix des actions Ajax avec aussi quatre colonnes,
3) le volume de transaction des actions Acme qui est constitué d’une seule colonne,

4) le volume de transaction des actions Ajax, constitué d’'une seule colonne.

Variantes des diagrammes de cours

L'assistant de diagramme propose guatre variantes, comme on le voit sur la Figure 77. Notez que
certains n’utilisent pas toutes les colonnes.

Type de diagramme

[a_ Colonne

= Barre b Ly
Secteur ‘ bt ‘ N ‘I I ‘l I

lal Zone | |

[~ Ligne

l-* XY (dispersion) Diagramme des cours 1
| Bulle
£ Toile

[iL Colonne et ligne

Figure 77 : Variantes des diagrammes de cours.
Les variantes sont les suivantes (la table de la Figure 76 est utilisée pour les exemples) :

Diagramme des cours 1
Quand le diagramme ne s’appuie que sur les colonnes des cours les plus hauts et les plus
bas, cette variante affiche un segment vertical qui représente I'écart entre ces cours. Si la co-
lonne des cours de clbéture est aussi utilisée, un trait horizontal marque celui-ci (Figure 78).
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Diagramme de cours - Variante 1

30 — ACITIE
25 l- e A
20 I_
15 |' -
10 |—

Lundi Mardi mercredi jeudi vendredi

Figure 78 : Variante 1 du diagramme de cours affichant
les cours le plus haut, le plus bas et a la cléture.

Cours

Diagramme des cours 2
Cette variante s’appuie sur les cours a I'ouverture, au plus bas, au plus haut et a la cl6ture
pour générer le diagramme traditionnel en chandelier (Figure 79). En plus du segment verti-
cal entre les cours le plus haut et le plus bas, elle dessine un rectangle qui indique l'intervalle
entre le cours d'ouverture et le cours de cléture. Si la valeur a augmenté (cours d’ouverture
inférieur au cours de cléture) le rectangle est blanc ; si elle a diminué, il est noir.

Diagramme des cours - Variante 2
50

45
40
35 |

30 — ACTIE

%E 'TT -+ _|_[F*_A.ax

cours

10

Lundi Mardi mercredi jeudi vendredi

Figure 79 : Variante 2 du diagramme des cours affichant les plus au plus bas et au plus haut
ainsi que la variation entre le cours d’ouverture et le cours de cl6ture.

Diagramme des cours 3
Cette variante, semblable a la premiére, y ajoute des colonnes pour représenter les volumes
de transactions. Comme le montre la Figure 80, un axe Y secondaire permet de représenter
a la fois les cours et les volumes sur I'axe vertical.

Eg Remarque

Les variantes 3 et 4 alignent automatiquement les données sur I'axe Y secondaire. Pour
plus d’'information sur un axe Y secondaire, voir « Aligner des données sur I’axe Y secon-
daire », page 23.
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Diagramme des cours - Variante 3

5000 50
4500 45
4000 40
3500 35
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m \/olume Acme = \/olume Ajax Cours Acme === Cours Ajax

Figure 80 : Variante 3 du diagramme des cours affichant les cours d’ouverture,
au plus bas et au plus haut ainsi que les volumes de transactions.

Diagramme des cours 4
Cette variante, qui associe les cing colonnes de données, combine la variante 2 avec une
colonne pour représenter le volume de transactions comme la variante 3 (Figure 81).
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Figure 81 : Variante 4 du diagramme des cours affichant les quatre cours
(ouverture, plus bas, plus haut et cléture) ainsi que le volume de transactions.

Diagrammes colonne et lighe

Un diagramme en colonne et ligne est utile pour afficher deux séries de données ou plus, dis-
tinctes mais reliées, comme des volumes de ventes au cours du temps (colonnes) et des marges
de bénéfice (lignes). Il pourrait aussi afficher des lignes constantes pour un minimum et un maxi-
mum, comme celles que I'on voit dans les analyses médicales ou les contrdles de qualité.

Indiquez dans l'assistant de diagramme s’il y a 1 ou 2 lignes. Par défaut, la premiére colonne (ou
ligne) de la plage de données contient les catégories et les dernieres colonnes (ou lignes)
contiennent les données pour les lignes.

Vous avez le choix entre deux variantes :

Colonnes et lighes
Comme le montre la Figure 82, les colonnes sont dessinées cote a cbte pour faciliter la com-
paraison de leurs valeurs.
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Figure 82 : Diagramme en colonnes et lignes avec un axe Y secondaire.

Colonnes et lighes empilées
Les colonnes sont empilées les unes sur les autres pour que la hauteur totale représente la
somme des valeurs.
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Figure 83 : Diagramme en colonnes et lignes avec colonnes empilées.

Les diagrammes des figures 82 et 83 montrent les ventes et bénéfices réalisés par deux sociétés
pendant une période donnée. Notez qu'aprés création, les lignes et les colonnes n’ont pas la
méme couleur pour la méme société. Pour refléter le lien entre les ventes et les bénéfices d'une
méme société, changez individuellement les couleurs des lignes en cliquant sur celles-ci puis en
sélectionnant Formater la série de données dans le menu contextuel aprées un clic droit. Choisis-
sez la couleur et la largeur de ligne dans I'onglet Ligne de la boite de dialogue Série de données.

Pour formater l'arriere-plan, vous pouvez faire un clic droit sur la paroi du diagramme, sélectionner
la zone du diagramme puis choisir I'option voulue dans les onglets Zone et Transparence. Pour ali-
gner les deux séries représentant les bénéfices sur I'axe secondaire, voyez « Aligner des don-
nées sur I'axe Y secondaire », page 23.

Diagrammes de table dynamique

Les tables dynamiques sont des types patrticuliers de tableaux de données qui en simplifient la ma-
nipulation et I'analyse. Elles sont trés utilisées, surtout quand il s’agit de traiter de grandes quanti-
tés de données. Les diagrammes dynamiques s’appuient sur les tables dynamiques ; on les crée
en sélectionnant Insertion > Diagramme dans la barre de menu ou en cliquant sur 'icone Insérer
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un diagramme de la barre d’outils Standard, apres un clic gauche hors de la table dynamique. lls
héritent de nombreuses propriétés des autres types de diagrammes décrits dans ce chapitre, mais

possédent aussi d'autres caractéristiques décrites dans le chapitre 8, Utiliser les tables dyna-
miques.
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